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The user documentation has five sections:  

1. Overview: This document consists of information which applies to the application including installation, versioning schema, release notes, platform support and 
bugs/issues associated with this release. 

2. Gantt (Task Dependencies): The document covers all user interface elements and dialogs associated with the Gantt Chart such as task definition, task 
constraints, task links, resource constraints, the global options dialog and printing. 

3. Resource Scheduling: The document covers all user interface elements and dialogs associated with Resource Scheduling such as the relationships of resources 
and calendars, base schedule, default resource and schedule customization. 

4. Critical Path Analysis: The document explains the options and configuration capabilities of the Critical Path and Critical Chain capabilities of jxProject. 

5. Date&Timeline Formatting: This document describes how to use the Date Format dialog to define and assign date formats. Also the time line format dialog is 
described for customizing the headers of Gantt and Schedule charts. 

6. Resource Leveling: This document describes what resource leveling is and how it works in jxProject.  It also discusses how to alter the way that the project plan 
is leveled. 

7. Critical Path: This document explains many of the terms associated with critical path analysis and explains how to set up these calculations and display the results. 

8. Printing and HTML: This document describes how to print gantt and schedule charts to a printer or to HTML/images. 

9. Activation: This document describes the differences between an activated version of jxProject and the free version. It documents the activation process. 

10. Sponsor Updating: This describes the process that is used to do the adverting including details on how the process works and what information is being passed 
up to the server and down to the client. 

_____________________________________________________________________________________________ 

Release Notes:  The 2.7.0.2 version of jxProject. 

New features in 2.7.0.2: 

l Critical path capabilities such as, early start, early finish, late start, late finish, start float and finish float have been added along with many options to customize the 
calculation parameters for these values. The early/late – start/finish values can be displayed graphically on the Gantt chart. 

l The Option dialog has a new “Critical” panel that allows the user set various criteria for identifying tasks as critical. The tasks identified as critical are displayed 
graphically on the Gantt and Schedule charts. 

l A button has been added to the upper tool bar to allow one-click access to the options dialog. 

l The options and table/chart settings are now saved inside each project file when the project is saved. This ensures that when the file is opened later, or by 
another user, that the options and view settings are in the same state as when the file was saved. 

l When the user sets a start date for a task, and that date is earlier than the project start date, then the project start date is automatically moved back to the same 
date. 

l On the Gantt Chart, you may select the resource(s) name, and then drag and drop the resource(s) onto another task to move/add the resource(s). 

l When a new project is started, a resource named “myself” is automatically added to the project and all tasks added to the project will automatically have 
“myself” assigned to the task. The “myself” resource can be edited to reflect the name of an actual resource and the auto assign of the resource to tasks can be 
changed via the new “assigning resource” capability. 

l The user may now designate any resource in the project as the “assigning resource”. The “assigning resource” is automatically added to any newly defined task. 

l A file logging facility and accompanying dialog has been added under the Help option on the menu bar.  

Bug fixes in 2.7.0.2: 

l When a task is scheduled, it cannot start until at least one of the assigned resources is available to begin working on the task. However, a bug was discovered in 
that duration driven tasks with finish constraints on them, were being allowed to start without an available resource. This has been fixed. 
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Installation: It is best to refer to the download area of the jxProject.com web site for instructions on installation.  At the bottom of the download page are common 
installation problems as well as solutions to those problems. An automated installer/launcher is available for download and is provided for Windows platforms.  Java 
1.6 runtime environment must be installed on the computer and can be installed before or after installing jxProject.  There are also files and instructions for manually 
installing jxProject without the installer. Launch scripts in Windows (batch, vb script) and Linux, Solaris, Mac OSX (bash scripts) are provided. 

Platform support: The primary platforms of focus are Windows and Linux as they both have excellent Java environments provided by Oracle.   I have never tried 
jxProject on a Linux platform but I have heard reports that it works well.  I don't have access to a Mac, so I hesitate to declare the Mac as an officially supported 
jxProject platform, however there are many Mac/jxProject users out there so they must be having reasonable success. 

Version numbering: Elements of the version number are defined as <MAJOR>.<MINOR>.<PATCH>.<SKEW>.  The version number significance works from left 
to right.  The values are always in the numeric range of (0 … 255) inclusive.  Each release of the product will have a higher version number than the previous version, 
keeping in mind the order of significance rule.   

·        <MAJOR> Incremented for significant changes in product features 

·        <MINOR> Incremented for minor feature changes and/or significant bug fixes/performance improvements 

·        <PATCH> Incremented for minor bug fixes/performance improvements/documentation changes 

·        <SKEW>Incremented for multiple public releases of the same versioned product acting almost as a product build number.  An odd numbered skew indicates a 
non production (alpha or beta) release of the product while an even numbered skew indicates a production release of the product. 

Sponsor Panel:  The sponsor panel appears in the upper right hand corner of the 
main jxProject window.  It scrolls through a list of images/ads every few seconds as 
the application is running.  Double clicking on the image will initiate a web browser 
and take you to the sponsor’s site.  Information about advertising with jxProject can 
be obtained in the services section of jxProject.com. 

  

Known Bugs/Issues: 

1. ISSUE: If you have finish constraints on two or more summary tasks, you could get slightly inconsistent scheduling results if a summary task with a finish 
constraint (task A) directly impacts the scheduling of another summary task which also has a finish constraint (task B) and that the scheduling of task B also 
impacts the scheduled finish time of task A. I should put in a picture to describe how to create/avoid this situation. It is rare that finish constraints are used on 
summary tasks, and even more rare that they would be configured in this way, therefore I've decided to postpone the resolution of this issue to focus on issues 
which affect more users. 

2. Bug: Cannot uninstall jxProject; java.lang.UnsatisfiedLinkError: com.zerog.ia.platform.Sys.getSpecialFolderJNI  This problem occurs 
during uninstall on Windows platforms when installed against Java 1.6. This is a problem with the zerog, InstallAnywhere installer which is incompatible with Java 
1.6. InstallAnywhere is no longer being used by jxProject as of 10-Aug-2007. For those users that are affected by this uninstall bug, a procedure for removing 
the application has been published under the “Problems and Solutions” section of the user documentation of jxProject.com. 

3. BUG: JVM crash during print: You should always save your file before printing!  I have seen the JVM crash suddenly when printing large jobs (over 50 
pages).  I haven’t worked with this enough to know what might be causing it but it is something in Sun’s code or perhaps the print driver I was using. Phil Race 
at Oracle contacted me about this bug and we exchanged several emails. UPDATE: Sun has identified and corrected several problems regarding printing and 
fonts in Java 5.0 update 11, which resolves this problem. 

4. Bug ID: 4694478 REGRESSION: pageDialog() mixes up margins for some printers in landscape:  This is a bug in Sun’s code.  For some 
printers, when you are using landscape paper orientation, the top/bottom and left/right margins get reversed.  I have this happening on my HP psc 2110.  Sun has 
not given a date for fixing this problem. 

5. Bug ID: 4265778 Java2D incorrectly renders objects with large coordinates: This is Sun’s bug affects the print preview when the number of pages 
is greater than 20 along a row or column.  You will see inconsistent or blotchy rendering in the print preview as you scroll away from the top left of the print 
preview page.  This does not impact the actual printing, but it does make the print preview look a little screwy. 

 
 
Release Notes History:  

New features in 2.6.1.2: 

l The ability to drag and drop data from jxProject to other applications. For example, drag and drop from the Gantt table to/from a spreadsheet. 

l The ability to drag/drop tasks from the Gantt table/chart onto the Schedule table/chart; and the ability to drag/drop resources from the schedule table/chart onto 
the Gantt table/chart. 

l The ability select and drag tasks to alter their duration on both the Gantt and Schedule charts. Cursor changes provide visual user feedback. Data panels, 
indicating the new values of duration/work follow the cursor as these changes are made. Similar functionality is implemented for altering the lag of task 
links/dependencies. 

l The task edit dialog can be initiated on the schedule chart by double clicking a task on the schedule chart. The schedule edit dialog can be initiated on the 
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schedule chart by double clicking on a vacant area of the resource/calendar row. 

l The row height and time-line settings of the schedule chart and resource dialog are maintained and restored as the dialog/window is opened and closed. 

l The Indent and out-dent of tree table hot keys has been changed to Alt-Shift-Right arrow and Alt-Shift-Left arrow. 

Bug fixes in 2.6.1.2: 

l An undetected circular constraint violation was discovered during testing and has been fixed. This bug would have significant impact on the user if they 
encountered this defect. Upgrading is highly recommended. 

New features in 2.5.2.4: 

l The activation authentication now accepts the user id, or the users home directory. This is to better support users with roaming profiles. 

l The Ra- rank adjustment tool for resource leveling has been changed to make it more intuitive for users. Only tasks which are scheduled to occur at or after the 
start time of the successor task and have rank values less than the predecessor task are moved higher in rank during this operation. The effect is to move only 
those tasks that need to be moved to accomplish what the user wants. This should be more intuitive. 

l The expiration date of the software has been eliminated for production releases. Only beta software will have an expiration.  

Bug fixes in 2.5.2.4: 

l For windows users, the file open/save dialog always defaults to the users personal “My Documents” folder instead of the user home directory. 

l For windows users, the application preferences are now stored in the AppData folder, rather than the users home directory. This is to better support users with 
roaming profiles. 

l The “file not found” error was being presented to the user as an application exception, which scared some users. So it is a more friendly error message now. 

New features in 2.5.0.10: 

l The “Load Example” button was removed from the upper tool bar. The example project plans are now accessed from the Help pull down menu on the Menu 
Bar. 

Bug fixes in 2.5.0.10: 

l For some versions of Java the version number was not being parsed correctly causing some users to see an exception when opening or saving files. 

New features in 2.5.0.8: 

l None. 

Bug fixes in 2.5.0.8: 

l Problem: Java 1.6.0_02 on the Windows platform has a problem which can cause the application to freeze for up to several minutes when the user attempts to 
open or save a file. This issue is specific to the file dialog and zip files in the directories. Fix: An alternate dialog for selecting files to open/save files has been 
implemented for Windows users on the problem Java platform. 

New features in 2.5.0.6: 

l For the Windows platform the installer/uninstaller has been upgraded to use Inno Setup. Also, a new launcher has been implemented using Launch4j. The result 
is better integration with desktop; a faster and more reliable install/uninstall and smaller download size. 

Bug fixes in 2.5.0.6: 

l The optimizer was not performing as designed in some situations which resulted in tasks moving forward in the project plan instead of moving backwards. This 
sometimes resulted in an optimization going back and forth subsequently undoing the previous optimization and then coming back and doing the same incorrect 
optimization again on the next attempt by the user. A very frustrating experience I'm sure. There were a combination of 4 bugs identified and fixed that were 
creating these problems; all of which have been fixed. Please send an email to support@jxProject.com if you see inconsistent or odd behavior from the 
optimizer. 

New features in 2.5.2.4: 

l A dialog for editing task properties such as dependencies, lag, drivers, duration, work, notes. There are string search abilities for dependencies and resource 
assignment. 

l The ability to associate and edit a positive or negative lag between links. 

l A file history dialog for accessing the past 50 files opened or saved. The last four files appear on the file pull down menu. 

l The ability to select and drag/drop tasks on the Gantt chart to alter the duration.  
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l The ability to select and drag/drop task dependencies on the Gantt chart such as links and arbitrary constraints. 

l The addition of two new arbitrary constraints, must-start-before and must-finish-before. 

l Comments can now be associated with arbitrary constraints. 

l A “pop-up” context menu on the Gantt chart giving access to relevant dialogs and insertion of arbitrary constraints. 

l New columns on the Gantt Table: Work Breakdown Structure numbers (WBS), Info, Priority, Notes. 

l The ability to “flash” a graphical schedule for resources on a single task row in the Gantt chart via context menu. 

l The ability to control the visibility of columns for the Gantt and Schedule tables via dialog. 

l The addition of accelerator keys to select table rows/columns; activate context menus; indent and outdent. 

Bug fixes in 2.5.2.4: 

l The mouse wheel pan/scroll was sometimes being activated using the alt key, not any more. (Fixed) 

l The timeline format dialog could throw exceptions if null values were pasted into it. (Fixed) 

l In some valid situations, indentations of tasks or drag/drop of tasks were being disallowed due to circular constraint violations. (Fixed) 

New features in 2.4.0.2: 

l Cut/Copy/Paste has been added to all tables in jxProject. Tables with multiple row selection capability also have “fill up” and “fill down” capabilities. Standard 
accelerator keys are implemented. 

l Context menus (popup menus) have been implemented for all tables and are available via right clicking (popup gesture) on the tables. The menus have standard 
menu options depending on editing capabilities for the table. 

l If the user clicks the middle mouse button on a component that is within a scroll pane, a pan/scroll image will appear and the window will scroll as the user 
moves the mouse. This is similar functionality to that available in popular web browsers. 

l Full Time Equivalent (FTE) work hours. This concept has been integrated into jxProject and the values user customizable via the FTE panel in the Tools-
>Options dialog. FTE hours are now factored into the Gantt table so work and span hours are displayed and edited as FTE values. 

l Automatic Table column resizing has been implemented. Double click on the right table column header separator to have the column resize to show the full values 
in each table cell for the column. This functionality is standard for software spreadsheets and expected by the user. 

Bug fixes in 2.4.0.2: 

l The mouse wheel on the Gantt and Schedule tables were scrolling horizontally, it now scrolls vertically as the user expects. (Fixed) 

l The Gantt chart is now properly sized so trailing text on the tasks is not truncated. (Fixed) 

l Scheduling rules were being deleted from the Resource/Calendar during undo/redo operation “set as base calendar”. (Fixed) 

l Some users were dragging slowly and getting inconsistent results when attempting to drag/assign resources. The mouse drag gesture recognizer now has an 
increased amount of time to recognize the drag. (Fixed) 

l The main project window title had a problem where spaces in the file name had the characters “%20” inserted. Filename spaces now appear as spaces in the 
window title. (Fixed) 

l The links on the Gantt chart would sometimes be one pixel forward or down from the task they were connecting from. This was a pixel rounding error. (Fixed) 

New features in 2.3.0.2: 

l Alternate shading of table rows to help guide users eyes across the page. 

l Standard accelerator keys for undo/redo(cntrl -Z) file save (Cntrl+S) ... 

l Customizable date formats for start and finish times via pop up dialog. 

l Customizable TimeLine formats using custom date formats via pop up dialog. TimeLine automatically implements appropriate format based on the scale of the 
time line when the user is stretching or compressing the timeline. 

l Work fields can be specified down to the minute while duration can be specified down to 1/10th of a second.

 

l Resources can be added “on the fly” through the Schedule table or directly in the resource assignment dialog by typing in the name of the new resource directly 
into the table. 
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l The rule scheduling dialog now uses AM/PM time instead of 24 hour time. 

l Arbitrary constraints such as “start after” and “finish after” can be inserted and edited directly on the Gantt chart using accelerator keys (Cntrl- left mouse button) 
for “start after” and (Cntrl- right mouse button) for finish after. 

l When new tasks are inserted, the default duration is the same as the value of the duration column units in the table. 

l The last names of assigned resources are now displayed on the Gantt chart. 

Bug fixes in 2.3.0.2: 

l Undo/Redo for arbitrary constraints is now implemented. (Fixed) 

l Print preview was not working when the root node had a blank name. (Fixed) 

l Divide by zero exception during optimization due to tasks with zero duration. (Fixed) 

l Tasks were being scheduled in the next day for resources that were in far western time zones and had work schedules that were late into the evening. (Fixed) 

l The Options dialog checkbox for rendering tasks on the schedule chart was not repainting the chart after the user had changed the selection. (Fixed) 

_____________________________________________________________________________________________ 

New features in 2.2.1.2: 

l None. 

Bug fixes in 2.2.1.2: 

l The TreeTable “focus” was not behaving correctly; setting up a new project required the user to click the task name cell every time. The behavior is more natural 
now, the user can type in a task name, hit return, and type in the next task name. 

l Another “focus” related problem was that the rows selected in the TreeTable would be cleared whenever a change was made, even if it did not affect the table. 
This has been corrected and rows/cells will remain selected unless there is a significant change to the table. 

l Undo/Redo now results in the TreeTable rows being selected after an undo/redo which involves inserting or moving rows. This gives the user much better 
feedback as to what is happening. 

l The [Ra+] links were not exhibiting consistent rank altering behavior in situations involving summary tasks. 

l New projects used to say “New Project” in the top row, now it is blank. 

_____________________________________________________________________________________________ 

New features in 2.2.0.2: 

l The rank of a task now looks something like: 22 – 17 > 8. This is interpreted as follows: The rank is 22, the rank can be reduced to 17 without impacting 
predecessors of the task, and the absolute minimum rank of the task is 8. The rank can now be edited directly by the user. The rank determines the priority in 
which resources are assigned to tasks during resource leveling. 

l A resource optimizer was added that performs a resource optimization operation with the push of a button. It identifies gaps in the resource schedules and alters 
the rank of the task to reschedule it into the gaps. Keep pushing the button and more optimization is done and the project plan shrinks. The free version gets 10 
optimizations, the activated version has unlimited optimization. 

l A new kind of task to task link has been added called an RU link. RU stands for resource user. This link is a soft link, it only affects the calculation of the task 
rank, allowing the user to control the rank priorities without having to insert a hard link dependency link. This also keeps the optimizer from moving tasks that the 
user does not want moved as part of the optimization operation. 

l A couple of pseudo task links have been added called Ra+ and Ra-. They allow the user to alter the rank of a task relative to another task in a similar manner as 
link creation.  

l Full undo and redo support was added for all changes to tasks, links, resources and calendars. The free version supports an undo/redo stack of 10, the activated 
version supports an undo/redo stack of 50. 

Bug fixes in 2.2.0.2: 

l There is a bug in Sun's JVM that does not allow the printer to be selected from the page setup dialog. A new button was added to the print preview specifically 
for printer selection. 

l When saving a project plan as images, if there was a “.” in the path name where the html file was being saved, the supporting images would be saved into the 
wrong directory. 
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_____________________________________________________________________________________________ 

New features in 2.1.0.2: 

l The addition of “span” column in the Gantt task table. This complements the “work” and “duration” columns giving the user another option for driving the 
scheduling of a task. A span driven task will be scheduled over the work time of the first assigned resource on the task. This kind of task driver would typically 
be used for meetings. 

l The addition of a line (purple) which runs the full height of the Gantt and Schedule charts indicating the current time. It is on by default but can be turned off by 
the user in the options dialog. 

Bug fixes in 2.1.0.2: 

l None. 

_____________________________________________________________________________________________ 

New features in 2.0.0.2: 

l The ability to write turn off the scrolling advertising by activating the software. 

Bug fixes in 2.0.0.2: 

l On windows systems the users home, as reported by Java, is sometimes incorrect. So, on windows, the USERPROFILE environment variable will be used, if it 
is not available, then the Java System.getProperty(“user.home”) will be used. 

Files created under all previous releases of jxProject can be read directly into the 2.0.0.2 version.  The 2.0.0.2 release is scheduled to expire on December 31, 2005. 

_____________________________________________________________________________________________ 

New features in 1.2.0.2: 

l The ability to write out jxProject tasks and resource schedules as HTML and images. 

l Added a pop-up menu to the tree table cell which allows the user to expand/collapse one or all child/descendant nodes. 

l Added the software expiration date to the splash screen and Help-> about screen. 

l Added the jxProject version number to the exception dialog. 

Bug fixes in 1.2.0.2: 

l An exception was being thrown for some paper types when they were set as the default printer. An example was “tabloid”. 

l A flag: “-Dsun.java2d.noddraw=true” was added to the jxProject launcher to disable the use of direct draw on microsoft platforms. Some video cards to not 
properly support direct draw and I don't think it helps anything anyway. 

l Added flags: “-Xms30m -Xmx70m” to increase the initial memory and maximum memory used by jxProject. This looks to have improved the startup time a little 
bit. 

Files created under all previous releases of jxProject can be read directly into the 1.2.0.2 version.  The 1.2.0.2 release is scheduled to expire on January 1, 2005. 

_____________________________________________________________________________________________ 

New features in 1.1.0.2: 

l Improvement in the accuracy and performance of task finish constraints. 

l Reduction of print file sizes by reducing color complexity of charts. A print file that used to be 500MB is now about 1MB.  

l The ability to import and export jxProject compliant XML. 

l Improved the drag and drop interaction by changing the cursor during the drag operation. Also added the ability to move, copy or link tasks and resources using 
cntrl and alt keys. 

l The ability to add one or more resources to one or more tasks with a single drag and drop. 

Bug fixes in 1.1.0.2: 

l An exception was being thrown for project plans with more than 100 tasks. 

l If a resource had only one assigned task, that single task was not being shown in the schedule view. 
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_____________________________________________________________________________________________ 

New features in 1.0.1.2: 

l Support for proxies, transparent or authenticating and Socks. The Jakarta HTTPClient package is used. 

l A more explanatory dialog is presented to the user when attempting to run jxProject where the user's home directory is not writable. 

l An “edit” option was added to the pop-up context menu in the Schedule view for Schedule nodes. 

Bug fixes in 1.0.1.2: 

l Uncaught Exception dialog was reporting some exceptions to the user that were not serious problems. These include attempting to link a null task or indent a null 
task. 

l The options dialog now appears below the “Tools” menu item. 

l Fixed spelling errors in the Options dialog. 

l Support for changing the look and feel of the application was removed. It was the source of several bugs. The standard Java “Metal” look and feel is all that is 
supported. 

l The Update Advertisements dialog displays “Never” for the last update date if the ads have never been updated. 

_____________________________________________________________________________________________ 

New features in 1.0.0.2: 

l None. 

Bug fixes in 1.0.0.2: 

l Uncaught Exception dialog was not catching exceptions as it should. 

l Trying to print from a PC with no installed printer caused the application to lock. Now a default paper size is used. 

l Removed text on splash screen referring to “beta” software. 

l Updated documentation and web site screen shots. 

l Removed empty message dialog that would pop up when attempting to create a link that already existed. 

 
 
_____________________________________________________________________________________________ 

New features fixes in 1.0.0.1: 

l The creation of the .jxProject directory under the user's home directory to store the application state such as user preferences and advertising images. 

l Increased the sponsor window size to 468x80 to accommodate standard banner sizes. 

l Information can be exchanged between the application and www.jxproject.com to support advertising. Updating of advertisements occurs in a separate thread, 
under the users control. 

l Put in an exception reporting dialog. 

Bug fixes in 1.0.0.1: 

l None. 

_____________________________________________________________________________________________ 

New features fixes in 0.8.1.1: 

·        Printing of Resource Schedules. 

·        Ability to select paper size/orientation and printer via a print dialog. 

·        Printing of tables and charts breaks on column and row boundaries so they are not cut in the middle on a page. 

·        Targeted printer shows up as a “tool tip” over print and setup buttons. 
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Bug fixes in 0.8.1.1: 

·        Tables sometimes overlapped each other when printing, not any more. 

·        Very rare lockups in print preview layout should be gone.  I never found this bug but the architecture is much better and less likely to produce this kind of 
problem. 

·        Returning from Schedule Edit dialog would incorrectly set the row height of the Schedule view when the dialog was closed. 

_____________________________________________________________________________________________ 

Changes in 0.8.0.5: 

·        The ranking of tasks for resource leveling is more consistent. 

Bug fixes in 0.8.0.5: 

·        Deleting multiple tasks from the Gantt tree table was throwing an exception. 

·        In some rare cases, tasks were not being updated when changes were made to their rank values. 

_____________________________________________________________________________________________ 

New features in 0.8.0.1: 

·        The addition of an “Options” dialog which allows the user to customize the jxProject environment such as resource leveling and rendering options for Schedule 
and Gantt charts. 

·        Resource Leveling is enabled by default and tasks will always be scheduled to prevent over allocation.  It is impossible to over allocate resources when this is 
enabled. 

·        The scheduled work times of resources assigned to tasks can be displayed on the Gantt chart. 

·        The tasks assigned to resources can be displayed on the Schedule Chart. 

·        Task “Work” and “Duration” can be displayed in units of hours, days, weeks, months or years. 

·        The user can drag to reset the row height of the tree table. 

·        Resources can now be partially assigned to tasks. 

·        Toolbar buttons were added to allow switching between schedule and Gantt views. 

·        The new table column, “Rank”, was added to assist in resource leveling  

Changes in 0.8.0.1: 

·        In the previous version you could change the chart header width properties by dragging on the chart header with the left mouse button.  This has been changed to 
shift+right mouse button drag. 

·        Resource Leveling is enabled by default, if you load a previous project plan and make a constraint change, you could see things move around quite a bit as the 
solver performs the leveling. 

Bug fixes in 0.8.0.1: 

·        Array sort was not sorting the last element in the array. 
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JxProject 2.7.0.2 - Gantt 

User Documentation 

April 12, 2012 

  

 Gantt: If you are familiar with using other project management software packages then jxProject should have a look and feel that is familiar to you.  The software is 
based on the Gantt Chart which was developed by Henry Gantt (1861-1919) to be used for scheduling multiple overlapping tasks over a time period.  jxProject allows 
you to build dependencies between tasks and it rebalances the project plan to reflect those dependencies.  Dependencies are often/usually referred to as constraints. 

Main components of the jxProject Gantt interface: 

  

 

Figure 1: The Gantt Interface 

  

The labels used in describing the basic components of the jxProject interface in Figure 1 will be used consistently throughout this document. 

Elements of the Gantt Chart:  While we have Figure 1 starring at us lets cover a few basics.  The tree table and the Gantt Chart are closely related and only serve as 
alternative visual representations of the exact same data.  Each row in the table represents the data in the same row in the Gantt Chart to the right.  The data which fuels 
these interfaces is a collection of user defined tasks.  These user defined tasks have relationships between each other which are also user defined.  That’s really all there 
is to this tool.  Sounds simple enough eh?  However, because of the variety of relationships you can define between tasks, project plans often become amazingly 
complex.  But no matter how complex the project plan gets, it is simply a group of tasks and the relationships between them.   Now a few definitions: 

1.      Task: This is the “atomic element” of a project plan.  It has a start date, duration and an end date.  These are represented on the chart as black outlined 
rectangles with a fine grained blue and white checkerboard fill color. 

2.      Summary Task: This is a “roll-up” of tasks which are considered “children” of these tasks.  A summary task must have at least one child task.  A summary task 
and its child task have a hierarchical relationship.  These are represented on the chart as solid black polygons which are largely rectangular. 

3.      Link: This defines a direct relationship between exactly two tasks where either or both tasks can be summary tasks.  One task of the link is called a predecessor 
task and the other link is called the successor task. These are represented on the chart as solid black lines between the two tasks with the arrow head pointing at the 
successor task. Resource User links are brown lines with “crows feet” on the ends, no arrow heads. 

4.      Arbitrary Constraint: This is a date constraint which appears as green/orange arrows in the chart. An arbitrary constraint will dictate that a task must start after 
or finish after a specific date. The finish after constraints are single headed green arrows where start after constraints are double headed green arrows. There are also 
must start before and finish before arbitrary constraints. 
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5.      Predecessor Task: Acts as the primary or driver task in resolving the relationship between itself and its successor task. 

6.      Successor Task: Acts as the subordinate task in the linked relationship between two tasks. 

 
 
Elements of the Tree Table:  A tree table is what you get when you cross a traditional GUI table with a traditional GUI tree.  It’s a table with expandable collapsible 
nodes.  The furthest left column of the tree table is the “key” field and it can never be scrolled out of view.  Every other column in the table can be scrolled and the 
order of the columns can be changed by dragging the columns into different positions using the column headers.  Now a few definitions: 

1. Key: Each task has a key value which is unique to all other tasks.  The key values are assigned by the software but the user can renumber them right clicking on 
the header. You can increase and decrease the table row height by pressing the (keyboard shift key and the right mouse key on the row table header) 
simultaneously and dragging it towards the bottom to increase the row height and towards the top to decrease the row height. 

2. Task Name: This is the name of the task or description of the task. 

3. Resources: These are the names of people assigned to this task.  If this field is blank then the “default resource” is assigned to the task. The first resource in the 
list is the “span resource”, so if a task is “span” driven, then the span resource schedule is what is used to calculate the start time and duration of the task. 

4. Work: This is the aggregated work hours of all resources assigned to the task during the duration of the task. A triangle in the upper left corner of this field 
indicates that work is the driving or constant parameter in the task and that span and duration are derived 
from the the work value. For work driven tasks: Duration = the absolute amount of time the task must 
endure in order to satisfy the required amount of work time from all assigned resources. Span = the 
aggregated work hours of the span resource during the duration of the task. The span resource is the first 
resource assigned to the task and is the first resource name in the list of resources. The work of summary 
tasks cannot be set by the user and is an aggregate of all is child task work values. NOTE: The custom 
schedule and time zone of each resource is used in these calculations. Also, these values are adjusted to 

represent Full Time Equivalent (FTE) values. Example: A work driven task would be one where the addition of resources would result in the task taking less 
time to complete as there are more people to do the work. If the task were, “digging a ditch”, adding more resources to the task would shorten its duration 
depending on the amount of work hours each resource was available over the duration of the task. 

5. Span: This is the aggregated work hours of the span resource during the duration of the task. A triangle in the upper left corner of this field indicates that span is 
the driving or constant parameter in the task and that work and duration are derived from the the span value. For span driven tasks: Duration = the absolute 
amount of time the task must endure in order to satisfy the required span work time. Work = the aggregated work hours of all of the assigned resources during 
the duration of the task. The span resource is the first resource assigned to the task and is the first resource name in the list of resources. The span of summary 
tasks cannot be set by the user and is an aggregate of all is child task span values. NOTE: The custom schedule and time zone of each resource is used in these 
calculations. Also, these values are adjusted to represent Full Time Equivalent (FTE) values. Example: A span driven task would be one where the addition of 
resources would NOT result in the task taking less time to complete. If the task were, “Have a meeting to review requirements”, adding more resources to the 
meeting would not make the meeting any shorter, but does increase the amount of work spent on the meeting. 

6. Duration: This value is defined as finish date – start date. A triangle in the upper left corner of this field indicates that duration is the driving or constant 
parameter in the task and that work and span are derived from the duration value. For duration driven tasks: Work = the aggregated work hours of all of the 
assigned resources during the duration of the task. Span = the aggregated work hours of only the span resource during the duration of the task. The span 
resource is the first resource assigned to the task and is the first resource name in the list of resources. NOTE: The custom schedule and time zone of each 
resource is used in these calculations. FTE values are not utilized in the display or edit of duration values. The durations of summary tasks cannot be set by the 
user. Example: A duration driven task would be one where the task takes an absolute amount of time regardless of resources. If the task were, “Wait 36 hours 
for paint to dry”, a duration driver is the way to go. 

7. % Complete: Has a range of 0 to 100.  It is used to indicate the amount of the task that is complete.  For summary tasks the % complete is aggregated from its 
child tasks and is weighted by the amount of work the child task represents. 

8. Resources: These are the first names of people assigned to this task.  If the field is blank then the “default resource” is invisibly assigned to the task. 

9. Rank: This is used to determine which task gets first priority to the Resources which are assigned to it.  If two tasks have the same Resource assigned to them, 
the task with the lower Rank value will be scheduled first.  The Rank of a task is determined by its row position and its constraints.  Tasks that are towards the 
top of the table will tend to get the lower Rank values.  A successor task always has a higher Rank value than its predecessor.  The Rank value is generated by 
the constraint solver but there are several tools available to the user to alter the ranking of tasks  See the documentation on Resource Leveling for more 
information. 

10. Start: This is the start date of the task.  This is an editable field but it is only used to add or change the start after constraint (Arbitrary Constraint) of the task 
which will be described later in the constraints section. 

11. Finish: This is the finish date of the task.  This is an editable field but it is only used to add or change the finish after constraint (Arbitrary Constraint)  of the task 
which will be described later in the constraints section. 

12. Predecessors: This is a comma delimited field of task keys which are predecessors of this task.  This field can be used to add, edit or delete predecessor task 
links. 

13. Successors: This is a comma delimited field of task keys which are successors of this task.  This field can be used to add, edit or delete successor task links. 

14. Priority: A user set of priorities from Lowest to Highest. The priority value does not affect the scheduling of the task. 

15. Notes: The notes associated with the task. Best accessed through the task edit dialog. 
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16. Info: A non-editable field which indicates a problem with the task such as an arbitrary constraint violation. 

17. WBS: A non-editable field showing the work breakdown number for the task; (ie. 2.1.4) 

18. Driver: A non-editable field indicating a numeric value for the type of scheduling driver for the task, work/duration/span. 

19. Early Start(ES): The earliest date/time that a task can start given its constraints. Dominant constraints are: Links: Start-to-Start and Finish-to-Start and 
Arbitrary constraint: Must-Start-After. 

20. Late Start(LS): The latest date/time that a task can start without impacting the scheduling of successor tasks or the project end. Dominant constraints are: 
Links: Start-to-Start and Start-to-Finish and Arbitrary constraint: Must-Start-Before. 

21. Early Finish(EF): The earliest date/time that the task can finish given its constraints. Dominant constraints are: Links: Start-to-Finish and Finish-to-Finish and 
Arbitrary constraint: Must-Finish-After. 

22. Late Finish(LF): The latest date/time that a task can finish without impacting the scheduling of successor tasks or the project end. Dominant constraints are: 
Links: Finish-to-Start and Finish-to-Finish and Arbitrary constraint: Must-Finish-Before. 

23. Start Float(SF): The amount of time remaining after subtracting the Early Start Time from the Late Start Time. SF = LS – ES. Float is sometimes referred to as 
slack. 

24. Finish Float(FF): The amount of time remaining after subtracting the Early Finish Time from the Late Finish Time. FF = LF – EF. Float is sometimes referred to 
as slack. 

25. Criticality: A calculated value based on the critical task criteria set by the user. These values cannot be edited, they range in value from Lowest to Highest. 
Critical tasks are displayed differently on the charts than non critical tasks. 

 
 
Constraint Elements:  This is a listing of constraints which affect the scheduling of tasks.  The user cannot directly set the start or finish dates of any task; this is done 
by the constraint solver which is contained within jxProject.  The user must define constraints which act upon the task in order to alter the scheduling of a task.   

1. Hierarchical: This is the parent/child relationship which exists between a summary task and one or more tasks.  A summary task starts at the same time of the 
earliest start date of its child tasks and ends at the latest finish date of its child tasks.  A child task is constrained to be scheduled within the constrained scheduling of its 
parent/summary task.  A summary task can contain millions of child tasks. 

2. Links: These define a direct relationship between exactly two tasks where either or both tasks can be summary tasks.  One task of the link is called a predecessor 
task and the other link is called the successor task. A task may have up to 1 billion links.  There are four link types: 

a. Finish to Start (FS) (default): The finish date of the predecessor task pushes the start date of the successor task. 

b. Finish to Finish (FF): The finish date of the predecessor task pushes the finish date of the successor task. 

c. Start to Finish (SF): The start date of the predecessor task pushes the finish date of the successor task. 

d. Start to Start (SS): The start date of the predecessor task pushes the start date of the successor task. 

e. Resource User (RU): The successor task is constrained to have a rank value that is greater than the predecessor task. 

f. Pseudo Links (Ra+, Ra-): These are not links, but tools to alter the ranking of tasks. They appear here only for completeness and are discussed in 
detail in the resource leveling documentation. 

4. Rank: The rank of a task determines the priority in which it is scheduled with respect to the resources assigned. The task with the lowest rank value gets resources 
before any other task. Rank is only relevant when resource leveling is enabled and it serves as the tie breaker in scheduling tasks which share the same resource(s). See 
the resource leveling documentation for more details. 

5. Arbitrary: This constraint is used when the scheduling of a task is determined by constraints which are outside the control of the project.  An example would be that 
you have a set of tasks in your project which depend on the arrival of a piece of equipment.  You would put in the arrival date of the equipment as an arbitrary 
constraint preceding those tasks which depend on the presence of that equipment.  A task may have at most one of each kind of arbitrary constraint.  There are four 
types: 

a. Start After: The task must start after this constraint. 

b. Finish After: The task must finish after this constraint. 

c. Start Before: The task must start before this constraint. (Not enforced by constraint solver) 

d. Finish Before: The task must finish before this constraint. (Not enforced by constraint solver) 

Note: The start/finish before constraints are not enforced by the solver. An impossible example: Task A must start on Monday and must finish one day 
later (Tuesday) and has a duration of 10.0 days. It is impossible for the constraint solver to resolve this set of constraints. The task will finish 10.0 days 
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after it starts and an “Error” will appear in the Info column of the Gantt table in indicate that the finish before constraint is being violated. 

6. Resources: Tasks are constrained to begin only when at least one of the assigned  resources is available to work.  If no resource is assigned, the schedule of the 
“Default Resource” is used to satisfy this constraint. 

Title Bar:  The title bar contains the jxProject logo/icon followed by the file name which is currently open.  Only one file 
can be open at a time. 

  

Menu Bar:     The menu bar consists of drop down menus which provide access to most of the functionality in 
jxProject.  Each of the menus is shown and outlined below. 

File Menu:  

   

· New: Create a new file. 

· Open…: Open an existing file (*.jxp) 

· Recent Projects…: Open a dialog showing the last 50 project files opened/saved. 

· Close: Close the file that is currently open. 

· Save: Save the currently open file 

· Save As…: Save the currently open file with a new name. 

· Import XML: Import a jxProject file which is in XML format. 

· Export XML: Export the jxProject file in XML format. 

· Print Preview…: This takes you to the print preview screen and you can configure the printer or 
print from there. 

· HTML/images…: This takes you to the image preview screen. From here you can view and alter the size of the images produced when you save the html file. The 
output is a simple html file utilizing the images of the table and chart. 

· 1: file:/c/... There will be a listing of up to 4 of the previously accessed files. 

· Exit:  Exit the application 

  

 Edit Menu: 

l Cut/Copy/Paste: Cut will copy the selected cells to the clipboard and set the values to their minimum or default values. Copy 
will copy the cell values to the system clipboard. Paste will paste values from the system clipboard to the selected cells. 

l Fill Up: For multiple row selections, the top cell value in a column will be copied down to all selected cells directly below. 

l Fill Down: For multiple row selections, the bottom cell value in a column will be copied up to all selected cells directly above. 

l Delete Task(s): All fully selected rows/tasks will be deleted. 

l Intent Task(s): Remove the selected tasks from their current parent and insert them as children of the parent of the task that is 
just above the top most selected task.  

l Outdent Task(s): Remove the selected tasks from their current parent and insert them as children of their current grandparent 
task. 

l Undo: Undo a previous edit such as add/delete task, link, resource or an updating of the properties of a task, link ... 

l Redo: Redo an edit that was previously undone by an undo.  

l Link Tasks: In the range of selected tasks (at least 2), working from top to bottom add a Task to Task link where the upper task is the predecessor. The type 
of link created is determined by what is selected in the Link Type selected in the pull down menu off of the lower toolbar. 

l Un-Link Tasks: Remove any and all links which exist between any of the selected tasks.  
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View Menu:  

l Gantt Chart: This will switch you into Gantt Chart Mode  

l Calendars/Resources: This will switch you into Scheduling Mode.  

  

 Insert Menu:  

l New Tasks(s): This will insert a number of new tasks just above the selected tasks.  The number of tasks inserted will be the same as 
the number selected. By default, new tasks are duration driven and have a duration value equal to one unit of the current setting of units 
in the Duration column of the Tree Table. So if the column is in “Hours” then each new task would have an initial duration of 1 hours. 

 Tools Menu:  

l License Activation...  : The Activation Dialog is accessed here. If you have obtained a valid jxProject Serial Number, you can 
activate the software to remove the scrolling advertising.  

l Update Advertisements...  : Another dialog will be presented asking you to confirm yes/no that you want to continue with 
updating. If you select yes, the update progress dialog will be placed into the sponsor window so you can monitor the progress 
of the statistics upload and downloading of new advertisements. The update process runs in a separate thread so you can 
continue your work while the update progresses, you don't have to watch it. ;-) If the update is successful it will turn green, if 

unsuccessful, it will turn red. Either way it will then return to scrolling some advertisements. If it has been less than two days since the last advertising update, you 
will see a dialog that tells you the ads are current and no updating will occur. 

l Network Settings... : This will bring up the Network Settings Dialog just below the “Tools” text. This dialog allows the user to set and test proxy settings. It is 
discussed further later in this document. 

l Date Formats... : This will bring up the date format dialog where you can add, edit or delete, the existing date formats. See the chapter on Dates and time line 
formating for more detail. 

l Options...  : This will bring up the Options Dialog just below the “Tools” text.  The capabilities of the dialog are discussed later in this document.  

  

Help Menu:  

l Documentation: A dialog directing you to go to www.jxProject.com will be shown. 

l Log Dialog …: This will open the Log Dialog which will allow you to view log files and their contents. You can also set the level of logging 
that is done. Caution: Logging lots of data to the log file will slow down the speed of the application, use the default logging levels for the 
best performance and logging. 

l Sample Projects >: There are three sample projects that the user can select and load in order to get familiar with jxProject's capabilities. These files can be 
edited and saved by the user, however, the sample projects stored with the application are not altered. 

l About…: This will display the splash screen showing the product name and version number.  

 
 

Upper Tool Bar:   The tool bar acts provides quick access to functionality which is accessible through the menu 
bar.  Working left to right the functionality is as follows: 

1. New File; see Menu Bar > File >New 

2. Open File; see Menu Bar > File > Open 

3. Save File; see Menu Bar > File > Save 

4. Print; see Menu Bar > File > Print 

5. Display the resource assignment dialog.  Used to drag/drop resources onto tasks and to view resource schedules. (See below) 

6. Display the Options Dialog; This will open the options dialog (See below) 

 
 

Lower Tool Bar:    The lower tool bar provides the following functionality: Working left to right the functionality 
is as follows: 
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1. Switch to Gantt View; This will switch the application to the Gantt View. If already in Gantt view, it has no effect. 
2. Switch to Schedule View; This will switch the application to the Schedule View. If already in Schedule view, it has no effect. 
3. OP: This will perform a single run of the resource optimizer. It will attempt to identify a task which can be performed sooner than it is currently scheduled without 

negatively impacting the schedule of any other task. See the resource leveling documentation for more details. 
4. Outdent; see Menu Bar > Edit > UnIndent Task(s) 
5. Indent; see Menu Bar > Edit > Indent Task(s) 
6. Link; see Menu Bar > Edit > Link Tasks 
7. Un-Link; see Menu Bar > Edit >Un-ink Tasks 

8. FS; This is a pull down menu to choose the kind of link for creation during any task to task linking operation. The letters used on this button will reflect the link 
type selected, so it won't always say “FS” as shown in the picture above. The possible link types are as follows: 

9. Hard Links: FS, FF, SF, SS 

10. Soft Link: RU – Resource User(RU) Link; See the resource leveling documentation for more details. 

11. Pseudo Links: Rank Adjustment (Positive – Ra+ or Negative – Ra-) These are not really links, but tools to alter the ranks of tasks relative to one another. See 
the resource leveling documentation for more details. 

12. Undo; see Menu Bar > Edit >Undo 

13. Redo; see Menu Bar > Edit >Redo 

 
Tree Table Interaction:   

 

 
 
· Key: Each task has a unique key that is assigned when each task is created.  You can renumber the tasks by “right clicking” on the header which will bring up a single 
option popup-up menu to renumber the tasks.   

· Task Name: This is the name or description of the task and you can type anything you like into the field.  The expand/collapse icons only appear on summary tasks 
and you can click on those icons to expand or collapse this task. 

· Work: The default display unit is hours.  Clicking on the work value of a task you will get a “spinner” editor with up and down arrow that allows you to adjust in 
increments of 0.1.  You can also type in your own values without using the arrows if you like.  You cannot change the work of a summary task.  NOTE: The 
work/span times are Full Time Equivalent (FTE) adjusted. Example: Lets say an FTE works 8.0 hours per day and the work in “Hours” is 24.0. If you change the 
work units to “Days” then the value will be 3.0 as it takes 3 FTE days to produce 24 hours of work. 

· Span: The default display unit is hours.  Clicking on the span value of a task you will get a “spinner” editor with up and down arrow that allows you to adjust in 
increments of 0.1.  You can also type in your own values without using the arrows if you like.  You cannot change the span of a summary task.  NOTE: The work/span 
times Full Time Equivalent (FTE) adjusted. Example: Lets say an FTE works 8.0 hours per day and the span in “Hours” is 24.0. If you change the span units to “Days” 
then the value will be 3.0 as it takes 3 FTE days to produce 24 hours of work. 

· Duration: This default display unit is days.  Clicking on the duration of a task you will get a “spinner” editor with up and down arrow that allows you to adjust in 
increments of 0.1.  You can also type in your own values without using the arrows if you like.  You cannot change the duration of a summary task. NOTE: The duration 
time is NOT Full Time Equivalent (FTE) adjusted. Example: Lets say the duration in “Hours” is 24.0. If you change the duration units to “Days” then the value will be 
1.0 as there are 24 hours in a day. 

Gantt Table header context/pop up menu: The Column Visibility option will bring up a dialog where you can see what columns are available and can adjust the 
visibility, width and order they appear in the table. The Date Format option is only available for columns that require defined date formats such as start and finish dates. 

·Work/Span/Duration Units: For the Work/Span/Duration fields you can change the units for displaying and editing the value by 
using the mouse to right click the Work, Span or Duration column header for the field and selecting the units for display.  The units for 
Work and Span are FTE adjusted values. Duration units are NOT FTE adjusted. 

· Start Date: The date displayed is the start date of the task.  If you edit this field it will create a “start after” arbitrary constraint for 

the task.   You cannot type values into the date field, but you can select one of the fields of the date with your 
mouse and the cursor will align to the right of the chosen field.  You can then increment or decrements this part of the date with the 
spinner buttons or use your keyboards up and down arrow keys.  You can also change fields, left or right using your keyboard arrow 
keys or picking with the mouse cursor. You can change the format of the Start Date by right clicking on the column header and 
selecting “Date Format...”. See the chapter on Date Formating and TimeLines for more details. 

· Finish Date: The date displayed is the finish date of the task.  If you edit this field it will create a “finish after” arbitrary constraint for the task.  

You cannot type values into the date field, but you can select one of the fields of the date with your mouse and the cursor will align to the right 
of the chosen field.  You can then increment or decrements this part of the date with the spinner buttons or use your keyboards up and down arrow keys.  You can 
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also change fields, left or right using your keyboard arrow keys or picking with the mouse cursor. You can change the format of the Start Date by right clicking on the 
column header and selecting “Date Format...”. See the chapter on Date Formating and TimeLines for more details. 

· Successors/Predecessors: This is a validating comma delimited field of linked task keys.  Default link types which are Finish to Start do not have any character 
designation but the other 4 links types(see constraints) do have 2 character designators (SS, FF, SF, RU). 

· Resources: To assign resources to a task via this table you must bring up the resources assignment dialog and drag one or more resources onto the task row to 
which you want the resource(s) assigned.  A resource in the dialog is selected when the entire row is selected. To initiate the drag you must press down the first mouse 
button on the “key” cell of the selected resource(s) and begin dragging quickly. To delete a resource from a task, double click the resource cell to bring up the editor 
list of all the resources.  Uncheck the check box next to the resource name or set the % spinner to zero which will also delete the resource from this task.  The spinner 
can be used to assign partial resources to tasks. 

· Table row header: The row header is the left most part of the tree table which contains the “Key” field.  You change the table row height by pressing the 
keyboard shift key and the right mouse key on the row header simultaneously and dragging toward the bottom to expand the row height and toward the top to 
compress the row height. 

· Hot Keys/Accelerator Keys: Shift+F10 will bring up the table context menu; Shift+Space will select the entire row for any selected cells; Cntrl+Space will select 
the entire column for any selected cells; Alt+Shift+I will indent selected tasks; Alt+Shift+O will indent selected tasks. 

· Dragging and Dropping: Using drag and drop it is possible to move or copy tasks. To initiate a drag, select one or more tasks using the TreeTable row header to 
select the entire row. Then press and drag the first mouse button on the “key” field of the selected task(s). Do this quickly so the drag gesture is recognized. Your 
cursor will change to reflect the type of drag operation that has been initiated. The default drag is a move, if you hold down the control key while initiating the drag, the 
operation will be a copy. A copy cursor has a “+” sign on it. When tasks are copied, links to tasks that are outside of the group of tasks will be removed from the 
newly copied tasks. 

· Tree Table Context/PopupMenu: If you “right click” on a cell in the Gantt Tree Table, or hot key Shift+F10 you will see the popup menu above. Most of the 
selections are the same as the Edit menu. However it also has options to expand or collapse the node. If you select the associated “+” button, the operation will act on 
all child/decedent tasks. For example, selecting the “+” on the Expand Node item will expand the node and all nodes that are children of that node, and any nodes that 
are children of those nodes and so on. 

 

 
 
Assigning Resources to tasks: To assign resources to a task via this table you must bring up the resources assignment dialog and drag one or more resources onto 
the task row to which you want the resource(s) assigned.  A resource in the dialog is selected when the entire row is selected. To initiate the drag you must press down 
the first mouse button on the “key” cell of the selected resource(s) and begin dragging quickly. If you want to assign one or more resources to multiple tasks in a single 
step. Highlight only the resource cells in the task table to which you want to assign resources, then drag resources from the Resource Dialog and drop them onto the 
range of selected resource cells. The resources will be assigned to all of the highlighted tasks. If a task is already linked to one of the resources, the existing relationship 
will be maintained and not altered. You can also drop resources onto the tasks in the Gantt chart. Also, you can drop tasks from the Gantt chart onto resources in the 
dialog to make the associations. 
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Figure 2: Assigning a resource to a task via Drag and Drop 

  

The spinner value associated with the resource is used to partially assign resources to tasks.  When you click the cell in the table, click 
as far to the right as possible as the checkbox is very sensitive and you can delete resources unintentionally.  I don’t like this interaction 
but it isn’t a show stopper so it makes the TODO list.  ;) 

  

Figure 3: Resource Table Cell Editor; for resource delete 

 Table Pan Scrolling/Auto scrolling: Pan scrolling the tree table is activated by single clicking on the table with the middle mouse button. The pan scroll will work for 
any component inside a scroll pane and gives the user the ability to fly over the component. 

Gantt Chart Interaction: There is not a lot of interactivity in the Gantt Chart but there are some things that you can only do from the Gantt Chart so read closely. 

l Editing: Double clicking on any item in the Gantt Chart will bring up the task edit dialog. The item that was clicked will be selected/highlighted if possible. You 
can edit or delete items associated with the task from the dialog. 

l Creating/Modifying Arbitrary Constraints: You can create these constraints by bringing up the context menu (right click the Gantt chart) and selecting “Set 
Arbitrary” and then the specific constraint that you want. The constraint will be placed at the row and position where you clicked to bring up the context menu. If 
there is a per-existing arbitrary constraint of the type you you selected, it will be moved to the new location. You can move arbitrary constraints once they are on 
the chart by selecting them and then dragging them left or right. To drag a selected constraint put the mouse over it, press down the first mouse button and drag. 

l Creating/Modifying Links: You can link two tasks by dragging from one row in the Gantt Chart to another.  It is not necessary to select the exact task itself 
from the row.  If you start to make a link but decide you do not wish to complete the operation, release the mouse in the same row in which you started the drag, 
or release it outside of the visible area of the chart. The type of link created when you release the mouse is determined by task link type setting in the toolbar pull 
down. You can modify the lag of a link by selecting it and dragging it left/right. To drag a selected link put the mouse over the point of the arrow head, press 
down the first mouse button and drag left/right. 

l Modifying Task Duration: You can modify the duration/work/span of any task on the chart (not summary 
tasks). First select the task by clicking on it. The place the mouse over the right most edge of the task, press 
down the first mouse button and drag left/right. Note, the “driver” of the task will affect how the task is 
scheduled after the drag is complete. For duration driven tasks, the task will end exactly where you release the 
mouse. However, for work/span driven tasks, the task duration will adjust so that the task stops during the work 
time of the resource(s) assigned to it. Example: Joe works 8 – 5; M-F and is assigned to task A which is a work 
driven task. You drag task A and release the mouse on Saturday, when Joe is not working. The task duration 

will adjust to finish at 8 the following Monday, or back to finish at 5 of the previous Friday. Hint, use the “Flash schedule” option to see where the “work time” is 
before dragging. 

l  

Pan Scrolling/Auto scrolling: If you are dragging in the Gantt chart you need to drag outside of the visible area of the chart in order to make the chart scroll 
during the drag.  This is inconsistent with the behavior of the table which only scrolls when you are inside the visible area.  This will be fixed in a later release. In 
the image above the user has activated pan scrolling by single clicking on the chart with the middle mouse button. The pan scroll will work for any component 
inside a scroll pane and gives the user the ability to fly over the component. 

·        Gantt chart header: The header defines the dates over which the entire project extends.  The 
upper scale is denoted in weeks and the lower scale is in days.  You can compress and expand the time 

scale by pressing the keyboard shift key and the right mouse key on the chart header simultaneously and dragging it to the right to expand the scale and the left to 
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compress the scale. As you expand/compress the time line it will automatically change formats to suit the level of scaling. There are at least 20 preset formats for the 
header and they can be fully customized by the user by the time line format dialog. Right click on the header and select “TimeLine Format...”, and a dialog for 
customizing the format will be displayed. See the chapter on Date Formating and TimeLines for more details. 

Gantt chart context menu: A right click on the Gantt Chart or Shift+F10 will bring up this context menu.  

 
 

1. Edit... : This will bring up the Task Edit Dialog for the task in the row. 

2. Flash Schedule : This will show the schedule time for the resources of the clicked task/row. The schedule will display for 
about 5 seconds and then be cleared. 

3. Set Arbitrary (Start-After, Finish-After, Start-Before, Finish-Before): An arbitrary constraint of the selected type will be 
placed at the point that the task/row was clicked. 

4. Chart Options... : This is brings up the options dialog that can also be accessed from the Tools menu. 

5. FTE-Work... : This brings up the options dialog with the FTE tab visible. 

6. Solver... : This brings up the options dialog with the Solver tab visible. 

 
 
Edit Task dialog: This dialog is accessed by double clicking the “key” cell of the Gantt Table or double clicking a row/task or item associated with a task in the Gantt 
Chart. 

 

The above image shows the General tab of the task edit dialog. Most of the items on this panel can also be edited through the table. For summary tasks some of the 
fields are disabled such as percent complete and driver/work/span/duration values, these values are calculated from their child tasks. 

 

The above image shows the Dependencies tab of the task edit dialog. Dependencies appear as “links” on the Gantt chart from one task to another. Through this dialog 
dependencies can be added, modified or deleted. In this image the user has typed a “?” into the task name field which serves as a wild card search character to find all 
tasks and display them in a dialog list for the user to select one or more tasks as dependencies. The user can enter the starting characters of any task and if there is just 
one match, that task will be added, if more than one match, then they are shown in the list. For example: if the user typed “buil” into the task name field and hit return, 
the dialog would pop up with tasks 6 and 10 since they both start with “Build”. The search is case insensitive. The user can also type the key # of any task in the the ID 
column to add a dependency.  

If the user double clicks on a link in the Gantt Chart, this dialog will pop up and the selected link will be highlighted in the table. 
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The above image shows the Resources tab of the task edit dialog. Through this dialog resources can be added, modified or deleted. In this image the user has typed a 
“sfgh” into the Resource Name field. As there were no resources with the name “sfgh” a timeout dialog is shown to the user explaining that the search returned no 
results and showing how the search was performed [first=”” middle=”” last=””].  

The resource name searches are case insensitive and there are a variety of ways to search. Example: “bob” would match “Bobby” 

FFF just search first name 

LLL, just search last name 

LLL, FFF search last and first name 

LLL, FFF MMM search last and first name and middle name 

FFF LLL search first and last name 

FFF LLL MMM search first and last name and middle name 

<SP>II just search resource initials; Note: <SP> indicates white space entry 

<SP>II<SP>I just search resource initials start and ends with; Note: <SP> indicates white space entry 

? Return a dialog listing all resources. 

The user can also type the key # of any task in the the ID column to add a resource. 

The timeout dialog, shown in the above image, is an informational dialog and has a countdown timer which starts as soon as it is displayed. When the timer expires, 
reaches zero, the dialog goes away. If you want to hold the dialog, click on the countdown number to stop the countdown, double click on the number to dismiss the 
dialog. 

This is the Options Dialog which allows the user to 
customize some aspects of the behavior and appearance of 
application.  There are four “tabs” on the dialog and each will 
be discussed below. 

Gantt Tab: These are options to alter the appearance of the 
Gantt chart. 

l “Display Resource Schedules”: If selected, the schedules 
work time of resources assigned to the tasks will be displayed 
in the rows containing the tasks. Note: this is a 
computationally expensive operation and will cause a 
noticeable slow down of the painting of the chart. 

l “Display Current Date Line (Verticle)”: If selected, a purple 
vertical line will be drawn on the Gantt chart which 
corresponds to the current date and time of the computer on 
which the application is running. 

l “Display Non-work Day shading (Verticle)” : If selected 
whole days where there is not work time scheduled for the 
base schedule will be shaded gray. However, the header time 
line lower scale must be in whole day units or the shading will 
not appear. 

l “Display alternating row shading (Horizontal)”: This will place a light shading on alternating rows of both the table and the chart. 
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l “Display Hard Links: [FS, FF, SF, SS]” If selected, these hard link types will be displayed on the Gantt Chart. 

l “Display Soft Links: [RU]” If selected, soft link types will be displayed on the Gantt Chart. 

Schedule Tab: These are options to alter the appearance of the schedule chart. 

l “Render Tasks Assigned To Resources”: If selected, the tasks assigned to a resource will be drawn over the schedule of the resource on the chart. 

l “Display Current Date Line”: If selected, a purple vertical line will be drawn on the Schedule chart which corresponds to the current date and time of the 
computer on which the application is running. 

l “Display Non-work Day shading (Verticle)” : If selected whole days where there is not work time scheduled for the base schedule will be shaded gray. 
However, the header time line lower scale must be in whole day units or the shading will not appear. 

l “Display alternating row shading (Horizontal)”: This will place a light shading on alternating rows of both the table and the chart. 

l “Render Summary Takes Assigned To Resources”: If selected, summary tasks assigned to a resource will be drawn over the schedule of the resource on the 
chart. 

l “Render Time Segments Location:  If “CENTER” is chosen, the time segments for each resource will be drawn in the center of the row, tasks would be drawn 
over the time segments.  If “TOP” is selected, the time segments will be rendered above the tasks which are being displayed. 

Resource Assignment Tab: These are options to alter the appearance of the schedule chart in the resource assignment dialog. 

l “Render Tasks Assigned To Resources”: If selected, the tasks assigned to a resource will be drawn over the schedule of the resource on the chart. 

l “Render Summary Takes Assigned To Resources”: If selected, summary tasks are drawn also.   

l “Render Time Segments Location:  If “CENTER” is chosen, the time segments for each resource will be drawn in the center of the row, tasks would be drawn 
over the time segments.  If “TOP” is selected, the time segments will be rendered above the tasks which are being displayed. 

Solver Tab: These are options relating to how the solver resolves constraints: 

l “Enable Resource Leveling”: If selected, tasks will be scheduled so that resources assigned to them are never over allocated. 

l “Super Solve”: This will force the solver to completely recalculate the schedule.  In most cases you won’t see anything happen, however if you load a project file 
which was not resource leveled, then push this button, you will likely see a lot of changes as the leveling is enforced. 

l “Clean-up Solve”: This will go through all pending model changes and solve them.  There should never be any pending model changes in the production version 
of the software so you should never see anything happen when this is pressed. This is mostly used for debugging during development. 

FTE-Work Tab: These are options to define the work hours of a full time resource: 

l Hours per Day: This is the number of hours an FTE will work on a typical work day. 

l Days per Week: This is the number of full time work days an FTE will work in a typical week. 

l Weeks per Month: This is the number of full time work weeks an FTE will work in a typical month. 

l The values of “Hours per Week”, “Hours per Month” and “Hours per year” are displayed and updated on the panel to provide information to the user. 

l These FTE values are used in the Gantt Tree Table columns for Work and Span. If a task takes 24 hours of work, and the FTE works 8 hours per day, then a 
work column displayed in days will have a value of 3.0. 24.0/8.0 = 3.0. 

Critical Tab: These are options which affect the calculation, criteria and display of critical tasks. See the document on “Critical Path Analysis”. 
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JxProject 2.7.0.2 – Resource Scheduling 

User Documentation 

April 12, 2012 

Schedule: The resource scheduling capabilities of jxProject are both flexible and powerful and thus they are somewhat more complex than other project management 
tools.  You would be well served to literally memorize the architecture and principles which are explained in this section.  All of the scheduling of calendars and 
resources is done using “rules”.  The rules are mildly complex however when you combine the importance of the order of the rules along with the interaction between 
resources and parent calendars, it can get very confusing.  Be sure to ground yourself with a solid understanding of the principles governing the interaction of Calendars, 
Resources, Rules and Segments. 

 

The Calendar/Resource Schedule Interface 

 
 

The labels used in describing the basic components of the jxProject interface in Figure 1 will be used consistently throughout this document. 

Elements of the Schedule Chart: The tree table and the Schedule Chart are closely related and only serve as alternative visual representations of the exact same 
data.  Each row in the Table represents the data in the same row in the Chart to the right. Each day is represented as a full 24 hour period starting at midnight.  Time 
which is scheduled as work or non-work time is shown for each day and is coded as follows. 

1. Work Time: This is represented as solid green with no outline. 

2. Non-Work Time: This is divided into paid and non-paid. Both of these time types have black outlines but the fill color for paid is green while the fill color for 
non-paid is gray. 

3. Chart Background: Areas of the chart which are colored gray are the days which contain no scheduled work time as defined by the “Base Schedule”.  The 
Base Schedule is explained below. 

4. Chart Header: The header defines the dates of the period of the schedule you are viewing. The upper scale is denoted in weeks and the lower scale is in days.  
You can stretch and shrink the time scale by pressing the (keyboard shift key and the right mouse key on the chart header) simultaneously and dragging it to the 
right to stretch the scale and the left to shrink the scale. 

5. Chart Pan Scrolling/Auto scrolling: Pan scrolling the chart is activated by single clicking on the table with the middle mouse button. The pan scroll will work 
for any component inside a scroll pane and gives the user the ability to fly over the component. 

Elements of the Tree Table: A tree table is what you get when you cross a traditional GUI table with a traditional GUI tree. It’s a table with expandable collapsible 
nodes.  The furthest left column of the tree table is the “key” field and it can never be scrolled out of view.  Every other column in the table can be scrolled and the 
order of the columns can be changed by dragging the columns into different positions using the column headers. The Tree Table contains nodes of two different types 
which are Calendars and Resources. The descriptions of the fields in the table are often similar between the two but not exact. Now a few definitions: 

1. Key: Each Node is assigned a unique key when it is created.  However, you can renumber them by “right clicking” on the header which will bring up a single 
option popup-up menu to renumber the nodes. 

2. Show: This is purely a diagnostic tool to assist you in identifying which rules are driving which parts of the schedule.  It is the only field in this table that is 
editable.  If this is unchecked, all of the rules defined in that node are no longer displayed on the chart.  Also, any nodes underneath the node, which inherit their 
scheduling from the node, are not displayed.  If you load up this example and uncheck the Zulu node, you will see a lot of the schedule disappear.  That is 
because most of the nodes are inheriting their schedule from the Zulu Calendar.  Whether these flags are on or off has no effect on the schedule used in solving 
the project plan. 
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3. Name: Calendars have a single name while Resources are listed as last, first, initial. If you type a name into a blank field a resource will automatically be created. 

4. Rules (count): This is the number of schedule rules which are associated with this node. 

5. Time Zone: This is a description of the time zone which governs this node which includes its offset from Greenwich Mean Time as well as general description of 
the areas of the globe which use that time zone. 

6. Tree Table row header:  You can increase and decrease the table row height by pressing the (keyboard shift key and the right mouse key on the row table 
header) simultaneously and dragging it towards the bottom to increase the row height and towards the top to decrease the row height. 

7. Table Pan Scrolling/Auto scrolling: Pan scrolling the tree table is activated by single clicking on the table with the middle mouse button. The pan scroll will 
work for any component inside a scroll pane and gives the user the ability to fly over the component. 

Key Components of the Schedule:  Every schedule for every project must contain the Zulu (GMT 00:00) Calendar as the root node and a Default resource.  Each 
project must also contain a node (Resource or Calendar) which is designated as the Base Schedule. 

1. Calendar: A Calendar can have its own time zone and can have an unlimited number of Calendars and Resources underneath it.  However, only Calendars 
which are directly underneath the root Calendar or Zulu Calendar can have their own time zones.  A Calendar that is more than 1 level deep must inherit the time 
zone from its parent Calendar.  In our example above, the “Part Time” Calendar gets its time zone from the Silicon Valley Calendar. 

2. Resource: A Resource always inherits its time zone from its parent Calendar.  A Resource cannot have any nodes underneath it. 

3. Zulu Calendar: This is always the root Calendar and it has a fixed time zone of GMT+00:00.  You can add or remove Rules from the Zulu Calendar and all 
nodes underneath Zulu will inherit those Rules. 

4. Base Schedule: There must be one and only one node designated as the Base Schedule, and it can be any Calendar or Resource which resides in the table.  
The Base Schedule determines the point of view from which the entire project plan is viewed.  All dates in the schedule and Gantt interfaces are presented in the 
time zone of the Base Schedule.  Also, the days which are determined to be “non-work days” are determined by the Base Schedule and appear as gray days in 
the chart backgrounds.  In our example above the Base Schedule is the Calendar named “Silicon Valley”.  You can set the Base Schedule by right clicking on 
the name of the node, you will get a pop-up menu with one option which is “Set as Base Schedule”, click that option and you’ll see the red arrow move to your 
selected node. 

5. Default Resource:  There must be one and only one Resource designated as the Default Resource.  It is designated by an icon of a “juggler” and it has a single 
rule to work Monday through Friday 8 hours per day (40 hours per week).  You cannot edit the Default Resource although you can drag and drop the Default 
Resource to change the parent Calendar in which the Default Resource is scheduled to work.  Any tasks which have no resources assigned to them automatically 
utilize the Default Resource schedule to satisfy the Resource constraint requirements. 

6. Assigning Resource: The assigning resource is automatically assigned to any newly created task. The assigning resource can be any resource in the project, 
including the default resource. When a new project is created, a resource named “Myself” is automatically created and is designated as the assigning resource. 

7. Rule: All Calendars and Resources can have an unlimited number of scheduling rules except, for the Default Resource.  Rules define a start and end time in days 
and contain filters for days of the week.  Rules can contain zero or more Time Segments. 

8. Time Segment: Segments range from zero to 24 hours in total duration and one Time Type per Segment. 

9. Time Type.  There are three types: Work Time(green), Non-Work Time (paid)(black outline; green fill) and Non-Work Time (unpaid)(black outline; gray fill). 

Have you memorized all of this yet?  ;-)  I’m only giving you definitions at this point, next I will go over the pieces of the interface and then I will give you a little story of 
how I expect you to use this interface.  I’ll even tell you some of the “gottchas” to be careful of.  You need to know all of this by heart to master jxProject.  There really 
isn’t anything you can afford to not understand if you want to build an accurate project plan using this tool. 

  

Title Bar:  The title bar contains the jxProject logo/icon followed by the file name which is currently open.  Only one file 
can be open at a time. 

  

Menu Bar:     The menu bar consists of drop down menus which provide access to most of the functionality in 
jxProject.  Each of the menus is shown and outlined below. 

File Menu: 

l New: Create a new file. 

l Open…: Open an existing file (*.jxp) 

l Close: Close the file that is currently open. 

l Save: Save the currently open file 

l Save As…: Save the currently open file with a new name. 
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l Import XML: Import a jxProject file which is in XML format. 

l Export XML: Export the jxProject file in XML format. 

l Print Preview…: This takes you to the print preview screen and you can configure the printer or print 
from there. 

l HTML/images…: This takes you to the image preview screen. From here you can view and alter the size of the images produced when you save the html file. 
The output is a simple html file utilizing the images of the table and chart. 

l Exit:  Exit the application 

Edit Menu: 

l Cut/Copy/Paste: Cut will copy the selected cells to the clipboard and set the values to their minimum or default values. Copy will 
copy the cell values to the system clipboard. Paste will paste values from the system clipboard to the selected cells. 

l Selection using Dialog...: This will bring up the Schedule edit dialog for the row that is selected in the TreeTable.  You must have 
one and only one row selected.  You can also double click on the “Key” of the node you want to edit a node with this dialog.  

l Fill Up: For multiple row selections, the top cell value in a column will be copied down to all selected cells directly below. 

l Fill Down: For multiple row selections, the bottom cell value in a column will be copied up to all selected cells directly above. 

l Delete Node(s): All fully selected rows/tasks will be deleted. 

l Intent Selection: Remove the selected nodes from their current parent and insert them as children of the parent of the node that is 
just above the top most selected row.  

l Outdent Selection: Remove the selected nodes from their current parent and insert them as children of their current grandparent node. 

l Undo: Undo the last edit. 

l Redo: Redo the last edit. 

View Menu: 

l Gantt Chart: This will switch you into Gantt Chart Mode  

l Calendars/Resources: This will switch you into Scheduling Mode.  

Insert Menu: 

l New Calendar(s): This will insert a number of new Calendars just above the selected row(s).  The number of Calendars inserted will be the 
same as the number of rows selected.  

l New Resource(s): This will insert a number of new Resources just above the selected row(s).  The number of Resources inserted will be the same as the 
number of rows selected.  

Tools Menu:  See The document for documentation on the tools Menu and the Global Options Dialog.  
Help Menu: 

l Documentation: A dialog directing you to go to www.jxProject.com will be shown. 

l Log Dialog …: This will open the Log Dialog which will allow you to view log files and their contents. You can also set the level of logging that is 
done. Caution: Logging lots of data to the log file will slow down the speed of the application, use the default logging levels for the best 

performance and logging. 

l Sample Projects >: There are three sample projects that the user can select and load in order to get familiar with jxProject's capabilities. These files can be 
edited and saved by the user, however, the sample projects stored with the application are not altered. 

l About…: This will display the splash screen showing the product name and version number.  

 
Upper Tool Bar:   The tool bar acts provides quick access to functionality which is accessible 
through the menu bar.  Working left to right the functionality is as follows: 

1. New File; see Menu Bar > File >New 

2. Open File; see Menu Bar > File > Open 

3. Save File; see Menu Bar > File > Save 
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4. Print; see Menu Bar > File > Print 

5. Display the Options Dialog; This will open the options dialog (See Gantt document) 

6. Start: The start time for the schedule chart. 

7. Years: The number of years shown in the schedule chart 

 
Lower Tool Bar:   The Schedule is mostly independent of the project plan.  You can view the 
schedules of your Calendars and Resource for hundreds of years into the past or future if you like.  

The default start date will be near your project start date but you can change this to anything time you wish to see.  

1. Outdent: see Menu Bar > Edit > Un-Indent Selection 

2. Indent: see Menu Bar > Edit > Indent Selection 

3. Undo; see Menu Bar > Edit >Undo (Note: Graphic needs updating) 

4. Redo; see Menu Bar > Edit >Redo (Note: Graphic needs updating) 

5. Zone Aware: If this is checked, then Chart areas will shift to their respective time zone offset relative to the Base Schedule.  Load the example file above and 
click this button on and off to see what I mean.  This is just used to help you with visualization of how teams in different time zones overlap or don’t overlap their 
work time schedules. 

Resource Utilization: This screen shot shows the 
schedule view with tasks and summary tasks being 
displayed with the time segments rendered on top of the 
tasks. The height of the rows has been increased so that 
the task keys and descriptions are readable. Tasks where 
the resource is less than 100% dedicated have a solid 
triangle painted in the upper left corner of the task. 
Summary tasks have a black outline and tasks have a blue 
outline. Basically this is a custom Gantt chart for each 
person on the project. Tasks which are associated with 
the default resource are not displayed or resource leveled. 
If resource leveling is enabled, it is impossible to over 
allocate resources. 

Tree Table Interaction: 

l Key: By double-clicking the key cell you can bring up the Schedule Dialog to edit the Calendar or Resource. 

l Show: This is the only field that is directly editable from the table.  It is used to help visualize which nodes are driving the schedule by allowing you to turn them 
on and off. 

Table row header: The row header is the left most part of the tree table which contains the “Key” field.  You change the table row height by pressing the 
keyboard shift key and the right mouse key on the row header simultaneously and dragging toward the bottom to expand the row height and toward the top to 
compress the row height. 

 
 
 
 
 

Tree Table Context/PopupMenu: If you “right click” on a Schedule Tree Table you will see the above popup 
menu. Most of the selections are the same as the Edit or Insert menus. However it also has options to expand or 
collapse the node. If you select the associated “+” button, the operation will act on all child/decedent nodes. For 
example, selecting the “+” on the Expand Node item will expand the node and all nodes that are children of that 
node, and any nodes that are children of those nodes and so on.  

 
Edit Node... option will bring up the edit dialog. 

Set As Base Schedule: Will set the associated node as the base schedule for the entire project. 
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Schedule Chart Interaction:  

· Schedule chart header: The header defines the dates over which the chart starts and ends.  The 
upper scale is denoted in weeks and the lower scale is in days.  You can compress and expand the time 

scale by pressing the keyboard shift key and the right mouse key on the chart header simultaneously and dragging it to the right to expand the scale and the left to 
compress the scale. As you expand/compress the time line it will automatically change formats to suit the level of scaling. There are at least 20 preset formats for the 
header and they can be fully customized by the user by the time line format dialog. Right click on the header and select “TimeLine Format...”, and a dialog for 
customizing the format will be displayed. See the chapter on Date Formating and TimeLines for more details. Note: The row height can be adjusted in a similar manor, 
see “Table Row Header” for specifics. 

Chart Interaction: The user can alter the duration and resource assignments of the tasks from the chart. To alter the duration select the task, then press down with the 
left mouse button on the right end of the task and drag left or right to alter the duration of the task. Drag and Drop of the tasks on the chart is also supported, see 
above. 

Task Edit Dialog: To initiate this dialog, double-click on a task in the chart. See the Gantt Chart documentation for images and specifics on the operation of this 
dialog. 

Schedule Edit Dialog:  To initiate this dialog double click on the “Key” field of the Calendar or Resource you want to edit. Or double-click on a blank space on a 
row in the chart. This dialog is the only way to edit most of the data associated with a Calendar or a Resource.  This dialog has three tabs which are: “Resource”, 
“Calendar” and “Rules”.  When this dialog is open, some of the buttons and other capabilities of the Schedule are disabled.  I’ll leave it as an exercise for the user to 
discover what you can and cannot do.  But you can double-click on another row in the table and load it into the dialog.  You don’t have to close the dialog to change 
Nodes.  If you have edits pending in the dialog, and you try to change selected nodes, you’ll get a warning to save or cancel your current changes. 

Set As Assigning Resource: Will set the resource as the resource to be assinged to any newly created tasks. 
The assgining resource has a green background. 

Dragging and Dropping: Using drag and drop it is possible to move or copy Calendars and Resources to/from the TreeTable to/from the chart..  

l TreeTable: To initiate a drag, select one or more rows using the row header to select the entire row. Then press and drag the left mouse button on one of the 
selected rows from the row header. If the drag gesture is recognized, your cursor will change to reflect the type of drag operation that has been initiated. The 
default drag is a move, if you hold down the control key while initiating the drag, the operation will be a copy. A copy cursor has a “+” sign on it. When 
Resources are copied, the tasks which were assigned to the original resources are not assigned to the copied resource(s). Be aware the time zones of copied 
calendars or resources can change based on their level within the hierarchy. 

l Chart: To change resource assignments, select the task, the press down with the left mouse button on the body of the task and drag the task and drop it on a 
different resource row in the chart to move the task. Hold the cntrl key down during the drag/drop operation to copy the task to another resource. 

 

 
Figure 1: Schedule Edit Dialog (Resource Tab):  

l First: The resource’s first name 

l Middle: The resource’s Middle name or initial 

l Last: The resource’s Last name 

l Title: The resource’s Title 

l Initials: The first character of each component of the full name in first, middle, last 
name order.  This will be generated automatically if you don’t type it in yourself.  If 
you type something in, that will override the automatic generation of the initials.  If 
you clear the initials field, it will automatically regenerate. 

l Entire Project: If this is selected then the always available according to the rules 
defined or inherited by this Resource. 

l From/To: If this is selected, then the availability is restricted to the From and To 
dates as well as the rules defined or inherited by this Resource. 
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Figure 2: Schedule Edit Dialog ( Calendar Tab):  

l Name: The name of the Calendar. 

l TimeZone: The time zone which this calendar and all Calendars and Resources 
below this Calendar will use.  NOTE: Calendars that are more than one level below 
the Zulu Calendar cannot have their own time zones.  In that case the time zone 
selection will be disabled. 

 
Figure 3: Schedule Edit Dialog (Rules Tab) 

Rules Table: This contains all of the rules defined for this Calendar or Resource. 
The order is always sequential and rules can overlap each other. The rule furthest to 
the bottom of the list takes priority in an overlap situation. The active field says 
whether the rule is active or not; inactive rules to not participate in any scheduling. 
The String field does nothing, I had an idea for it at one time but this will probably go 
away or be replaced with something else. The rules can be reordered by drag and 
drop. 

l New: Create a completely new rule in the table. 

l Copy: Copy the selected rule to a new instance. 

l Delete: Delete the selected rule. 

l Schedule Segments Table: This table contains all of the Time Segments that are 
defined for the rule which is selected in the Rules table. One rule can have multiple 
Segments. The Work Type is really the time type of Segment. The From, Duration 
and To times define the period of the day which is defined as this type of time. 

l Rule Builder: This part of the dialog applies once again to the rule which is selected 
in the Rules Table at the top of the dialog. 

l Name: The name of the rule; simple. 

l Active: Active rules are part of the schedule; inactive rules are not. 

l Days: Think of the days as a more filter for the rule where you can select specific 
days of the week where the Time Segments will apply. 
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If you’ve read through all of this excruciating detail up until now, I wouldn’t be surprised to find you passed out on the floor blowing bubbles.  I’ve written the above 
material in a reference fashion so you can refer to it in the future without having to wade through dialog that you don’t need.  Now we are going to get into how all of 
these little pieces fit together to form a schedule. 

 Review: 

1. Calendars and Resources exist in parent/child relationships.  Calendars can have Calendars and/or Resources as children but Resources cannot have any 
children. 

2. The schedule of Calendars and Resources is determined by the Rules which they contain and the Rules which their parent Calendars contain.  Rules can and 
often do overlap each other.  The Rule that is farthest down in the hierarchy and list order has the highest priority in an overlap situation!!! 

3. Rules contain zero or more Segments.  (A Rule should always have at least one Segment; zero is a mistake really).  In order for a rule to be enforced for a 
particular date, it must be active, the date must be between (inclusive) the start and end dates of the rule, the “day of the week” for the date must be selected for 
the rule, and the rule must not be overridden by another rule which is lower in the hierarchy/list and satisfies the active, start, end, day-of-week requirements. 

4. Segments define a time type and a period of time within a 24 hour period.  Segments cannot overlap and always appear in early to late order.  If you define the 
Segments in an unordered or overlapping fashion, jxProject will immediately sort the segments and remove any overlap.  It’s kind of unfriendly that way but it 
removes ambiguity. 

  

Recommendations on how to organize your Rules to build Schedules: 

1. You want to put your most basic scheduling rules inside Calendars and as high up in the hierarchy as possible.  For example, if you regular work week is 
Monday – Friday 8 to 5; put that rule up in the Zulu Calendar so everything can inherit that Rule. 

2. You should group people that have similar schedules together under Calendars.  In our example project, the “Silicon Valley” team and the “Koblenz, Germany” 
team belong to separate Calendars.  This is needed in order to give those people separate time zones but also to accommodate different Holiday schedules.  
Also, notice the “Silicon Valley” Calendar has a Calendar underneath it “Part Time” which schedules Monday and Wednesdays as non-work days to override 
the 40 work Rule.  The result is that the Resources under the “Part Time” Calendar are only scheduled to work 24 hours a week; Tuesday, Thursday and 
Friday. 

3. Put your Holidays, such as Christmas, just below your 40 hour work rule inside a Calendar.  The “Silicon Valley” calendar has several Rules defined for North 
American Holidays. 

4. Resources will usually only contain Rules which schedule non-work time to override the regular 40 hour work rule.  These would typically be to schedule 
vacations or account for personal days off. 

l Dates: OK, now things get a little complicated. :-o  You are going to need to experiment with this in order to really understand how it works. 

l Starting: This enables the starting date field so you can define a date (inclusive) at which this rule becomes enforced. 

l Always: This disables the starting date field as this means that this rule is always in effect going back in time to infinity. 

l Repeats: This is so you can make a week based cycle schedule.  Do you want this rule to be in effect every week (1), every other week (2), every third week 
(3)…  You must specify a starting date for this feature to be enabled. 

l For: This is so you can specify how may cycles you want this rule to be in effect.  If you specified every week(1) for 3 occurrences that would make the rule 
effective for 3 weeks from the start date.  If you specified every other week (2) for 3 occurrences that would make the rule effective for 6 weeks.  Simple huh? 

l Ending: This enables the ending date field so you can specify the last effective date (inclusive) of this rule. 

l Forever: This disables the ending date field as this means that this rule will always be in effect through to infinity. 

l Note: There are various combinations of these check boxes that will enable and/or disable other check boxes because not all options are applicable in all 
situations.  It is an ugly looking double nested if-then-else block which would be painful to describe.  My recommendation, push buttons … you’ll see how it 
works. 

Gotchas: Make sure you have the “days” selected that you want to rule to apply on.  It’s very easy to make a mistake by focusing on the start and end dates and 
cycles and forget to filter for the correct days of the week. 

Schedule Edit Dialog Buttons: 

l OK: Save changes and exit the dialog. 

l Apply: Apply changes but leave the dialog open. 

l Reset: Cancel all changes back to the last saved. 

l Cancel: Cancel all changes and exit the dialog. 
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5. Be descriptive with the names of your Rules to assist in troubleshooting should the need arise.  If you are scheduling a week of time off to go bike riding in 
August, call it the “5 days August biking” Rule. 

  

Test your Knowledge: 

1. How many Rules would be required to establish a schedule where a group of three people worked Tuesday and Thursday from 9am to 5pm and Monday, 
Wednesday and Friday from 6am to 3pm?  Answer: 2 Rules. 

2. How many Rules would be required to schedule a person as on Vacation for one day?  Answer: 1 Rule 

3. How many Rules would be required to schedule a person as on Vacation for Thursday, Friday and Tuesday where Saturday, Sunday and Monday were already 
scheduled off by the parent Calendar?  Answer: 1 Rule – Define the Rule for the period of Thursday through Tuesday and only select the days Thursday, Friday 
and Tuesday as the days-of-week for enforcement. 

4. Can you define a Rule with no Segments?  Answer: Yes, but it would have no effect on the Schedule. 

5. Can you define an active Rule that has valid defined Segments but has no effect on the Schedule?  Answer: Yes – If you do not select any of the days-of-the-
week it would be the same as no Rule at all. 

6. Could you define a single rule that Schedules a person for time-off every fourth week on Friday and Monday for the next six months?  Answer: Yes 

7. Can a single Rule that has 3 Time Segments enforce only 1 of the Segments on a particular day?  Answer: No – When a Rule is enforced all of its Segments are 
used on that day that it is active. 

  

Techniques for Trouble Shooting Schedules: 

After implementing your schedules you should always confirm your schedule is correct by closely reviewing the schedule chart for each of your Resources over the 
period you expect your project to run.  If you find the schedule does not reflect what you think it should, you are going to need to do some investigation.  Because rules 
are inherited and do override each other things can get confusing.  There are diagnostic tools built in to help you isolate the problem. 

Let’s say you find a day for one of your Resources that are scheduled as paid-time-off but should not be.  How do you find where this is coming from?  First you need 
to find the Rule responsible for this “day off”.  It has to be coming from the Resource its self, or one of the Resource’s parent Calendars.  Toggle off the “show” 
checkbox in the Tree Table for the Resource and parent Calendars until this particular day off disappears.  That will tell which Node owns the Rule that is scheduling 
the day off.  Now toggle the show button to “on” and open up the Schedule Edit Dialog for that Node to review the rules.  You could work in a brute force fashion and 
select each rule, make it “inactive” and press the “apply” button.  This will turn off the rule and update the schedule.  When you see the day off disappear, then you’ve 
found the rule that’s causing that day off.  You’ll need to take it from here to resolve the problem. 
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JxProject 2.7.0.2 – Critial Path Analysis 

User Documentation 

April 12, 2012 

  

The critical path of a project is the longest sequence of tasks in the project plan which must be completed on time for the project to complete on schedule. Therefore 
the critical path is composed of a sequence of critical tasks. Critical tasks are those tasks which cannot be delayed without negatively impacting the project delivery 
date. 

Definition of terms used in critical path analysis: 

1. Critical Path Method (CPM): A method of scheduling project activities/tasks according to their networked constraints. Note: Pure CPM assumes the resources 
required for activities/tasks are always instantly available. 

2. Resource Leveling: The altering of task schedules to avoid the overallocation of resources. 

3. Critical Chain Project Management (CCPM): A method of planning and managing projects that puts the main emphasis on the resources required to execute the 
project plan. 

4. Early Start(ES): The earliest date/time that a task can start given its constraints. Dominant constraints are: Links: Start-to-Start and Finish-to-Start and Arbitrary 
constraint: Must-Start-After. 

5. Late Start(LS): The latest date/time that a task can start without impacting the scheduling of successor tasks or the project end. Dominant constraints are: Links: 
Start-to-Start and Start-to-Finish and Arbitrary constraint: Must-Start-Before. 

6. Early Finish(EF): The earliest date/time that the task can finish given its constraints. Dominant constraints are: Links: Start-to-Finish and Finish-to-Finish and 
Arbitrary constraint: Must-Finish-After. 

7. Late Finish(LF): The latest date/time that a task can finish without impacting the scheduling of successor tasks or the project end. Dominant constraints are: 
Links: Finish-to-Start and Finish-to-Finish and Arbitrary constraint: Must-Finish-Before. 

8. Start Float(SF): The amount of time remaining after subtracting the Early Start Time from the Late Start Time. SF = LS – ES. Float is sometimes referred to as 
slack. 

9. Finish Float(FF): The amount of time remaining after subtracting the Early Finish Time from the Late Finish Time. FF = LF – EF. Float is sometimes referred to 
as slack. 

10. Forward Pass: The early start/finish values for each task are calculated by moving sequentially through the network of project dependencies and constraints 
starting with the earliest scheduled task and ending with the latest scheduled task. 

11. Backward Pass: The late start/finish values for each task a calculated by moving sequentially through the network of project dependencies and constraints 
starting with the latest scheduled task and ending with the earliest scheduled task. 

The definitions of project management terms can vary somewhat depending on the source. For example, “start float” and “finish float” are often defined as as single 
value,“float”. However, many software packages, including jxProject, have moved beyond this definition and allow start and finish floats to differ. Where ever possible, 
jxProject adheres to accepted definitions for the above defined terms. However, jxProject has several capabilities that go beyond what is often defined in typical 
Project Management texts or software packages. JxProject uses full 24 hour days with resources usually working only a fraction (8 hours) of those days. JxProject 
allows resources to work different/irregular schedules and in different time zones. Thus jxProject incorporates the gaps in resource schedules as part the reality of the 
project plan. Virtually all other software packages ignore the variability of resource schedules/constraints and simply define each day as a “work day” where the 
resource works the entire time. They appear to do this in order to simplify the underlying calculations of the software and also to be able to comply with the original 
project management definitions. However, these project management terms were formalized in the 1950s, long before the widespread use of personal computers. In 
the 1950s they needed to reduce the variability/parameters they were incorporating so that a project plan could be created and maintained using just pencil and paper. 
It is surprising that these simplified project management terms continue to dominate more than 20 after the personal computer revolution. 

This document contains significant detail of how values are calculated over a variety of situations and option settings. They might be a little more painful to understand 
than other packages that utilize a more simplified approach as discussed above. 

The traditional definition of Critical Path Method(CPM) does not include constraints imposed by resource availability. Critical Chain Project Management(CCPM) 
does incorporate resource leveling. JxProject performs CPM and resource leveling and some CCPM analysis. Note: CCPM is a lot more than CPM + resource 
leveling and has a lot of management philosophy which is not Implemented in jxProject. 
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Illustration 1: Critical Method options and Gantt Chart 

Illustration I shows a Gantt chart with several critical tasks, which are orange/stripe in color. The option dialog with the Critical tab showing shows what options are set 
to achieve this chart. The tasks which are orange/stripe are flagged as critical tasks making up the critical path. The green bars on the chart range from the early start to 
the early finish. The magenta/purple/red bars on the chart range from the late start to the late finish. Looking at the Critical panel in the dialog you see the options that 
were set to achieve this chart. The critical panel for the Option Dialog is discussed in detail below. 

Note: The definition of critical task criteria does not alter the scheduling of the tasks in any way. Critical path values, as defined above, are calculated for every task, 
every time the user alters a dependency, constraint or duration of any task. This happens regardless of the user defining critical task criteria or showing critical path 
values in the tables. It is not necessary for the user to understand critical path analysis to create and execute a project plan. CPM is a standardized (mostly) method of 
helping a project planner to locate areas of the project plan that MUST complete on time for the project to complete on time. All of the options for configuring the 
critical path/chain is contained within this tab of the Options Dialog. Let's go by sections of the tab: 

Method:  

1. Automatic Selection: If this is selected, then the Critical Path 
or Critical Chain method is selected automatically. If resource 
leveling is disabled, then the Critical Path is automatically 
selected, if resource leveling is enabled, Critical Chain is 
automatically selected. Note: Resource Leveling is 
enabled/disabled from the Solver tab of this Options Dialog. 

2. Critical Path: If this is selected, the early/late – start/finish 
values are calculated using task links, lag, arbitrary constraints. 
ALL resource constraints are ignored. Critical path can be 
used while resource leveling is enabled. 

3. Critical Chain: If this is selected, the early/late – start/finish 
values are calculated using the same parameters as Critical 
Path, but resource constraints (preventing overallocation) are 
also incorporated into the calculations. Note: If resource 
leveling is disabled, Critical Chain calculations will be the same 
as critical path calculations. 

Definition Critical Tasks:  

1. Start Float % Ascending: If the check box is enabled, this becomes functional. The project tasks are sorted(lowest to highest) by start float. The highest start 
float value, within the % of the tasks, is then set as the threshold for critical tasks. Example: If this is set to 20% and there are 100 tasks in the project, the start 

float value of the 20th task in the sorted list is the threshold value for criticality. After the % spinner is a label which represents the Start Float threshold value that 
the 20% turned out to represent. This value is updated each time the project is solved. 

2. Finish Float % Ascending: This is exactly the same as the for the start float above, just using the finish float value. 

3. Start Float less than: If the check box is enabled, any task with a start float value less than this value is considered critical. 

4. Finish Float less than: If the check box is enabled, any task with a finish float value less than this value is considered critical. 

5. Finish to Late Finish less than: If the check box is enabled, any task where the tasks late finish date, minus the tasks actual finish date is less than this value is 
considered critical. 

Condition where actual dates used for Early Start/Finish 

1. None: No Date is being used. 

2. Current Date/Time: If this is selected, a verticle red/magenta line will appear on the Gantt chart at the current time. For all tasks which are schedule to 
complete, prior to this date, their early start and early finish values will be set to the tasks currently scheduled start and finish values. 

3. Date: If this is selected, the user may set this date to any value. For all tasks which are schedule to complete, prior to this date, their early start and early finish 
values will be set to the tasks currently scheduled start and finish values.  

4. Use Actual Dates if % complete over: If this is selected, for any task which is marked completed higher than this percentage, their early start and early finish 
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values will be set to the tasks currently scheduled start and finish values.  

5. Minimum Date Being Used: This is feedback to the user to show what date is being used for the early start/finish values setting to actual above. 

Display on Charts: 

1. Early Start / Finish Bar: If this is selected, the green early start/finish bar is shown on the Gantt chart. 

2. Late Start / Finish Bar: If this is selected, the green early start/finish bar is shown on the Gantt chart. 

3. Early to Late Connections: If this is selected in addition to the selection of the early and late bar options, then a line is drawn, for each task, from the early start 
to the late start, and from the early finish to the late finish. 

Project Late Finish Date should default to Scheduled Project Finish Date: The default late start of the project is set to the early finish of the project during the 
start of the backward pass, late value calculations. If this selected, the late start of the project is set to the scheduled finish of the project. Note: The late finish of a 
project will be set to the “must finish before” value if it is set via arbitrary constraint. 

 
 
Discussion and Recommendations: 

Lets go over a few examples of critical path settings and what situations you may find them useful. 

Traditional Critical Path Options: These settings will result 
in the most traditional CPA results. If you are just getting 
familiar with jxProject, this is a good set of options to start 
with. The method has been forced to “Critical Path”. The 
conditions for scheduled dates used for Early Start/Finish are 
not selected. The Project Late FinishDate is allowed to go to 
its default value.  

The critical path definitions cover all of the bases, show the 
top 5% most critical and those that have less than a day of 
float. This is a good set of criteria, you may want to go with 
the top 10% or %20. 

The Finish to Late Finish less than is not used, if resource 
leveling is enabled and you have forced CPA, this option 
tends to end up flagging all of the tasks or none of the tasks as 
critical. 

None of the “Conditions where scheduled....” options are set 
in this example. However, now is a good time to discuss using 
these options.  

By default, the late finish of the project is the same as the 
early finish of the project. As you move forward in the 

project, the CPA values diverge more and more from the actual scheduled dates of the tasks. It would not be uncommon for a 6 month project to show the late finish 
of the project a couple of months before the scheduled project finish. This is because the gaps in the scheduling of the tasks due to unavailable resources pushes tasks 
out, while the CPA values do not incorporate these gaps. Therefore, the CPA values can be much earlier than the tasks are actually scheduled. There are several things 
the user can do to bring the CPA dates forward to better coincide with the scheduled dates. 

If the user selects/enables the “Current Date/Time” then as the project moves along, tasks that complete before the current date/time will have their early start/finish 
values set to the scheduled values of the task. This has the effect of moving the early finish of the project to a later date and thus the late finish of the project is moved to 
a later date. So the differences between the CPA values and the scheduled values tend to be reduced. Similarly, the user can set a specific date which will have the 
same impact around the date the user chooses. This is useful if the user wants to see what the CPA values will look like at some date in the future. Also, the user can 
set a threshold of completeness where if a task is, for example, 95% complete, then the early start/finish dates are set to the actual dates and the subsequent alignment 
of a later early finish would follow.  

Now lets discuss the reasons one might select the option: “Project Late Finish Date should default to scheduled Project Finish Date”. Lets say you have a 
project plan that you are happy with, you will be happy if the project plays out as scheduled. In this case, you want to see how late your tasks can run before they 
impact the scheduled completion date. Selecting this option will do that. It will usually cause the float values to become much larger as this is not traditionally how CPA 
late values are calculated. If you do select this option, then it might make sense to select the option: “Finish to Late Finsh less than”.  

These CPA options are set to allow the user to see which 
tasks are in danger of not making their scheduled completion 
dates. The options “Project Late Finish Date should 
default to scheduled Project Finish Date” and “Finish to 
Late Finsh less than” are both selected to help the user 
visualize this on the chart. The “Finish to Late Finsh less 
than” is set to 2.4 days which will flag any task that is within 
that duration of slipping and impacting the project. 
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The start and finish float hard values are not enabled as the 
user will likely find they are not flexible enough, especially 
when turning on and off the “Project Late Finish Date 
should default to scheduled Project Finish Date” option. 
The user is encouraged to toggle and apply these options to 
see the effects and gain perspective on the project plan and 
this tool.  

The “Critical Chain” option only works if resource leveling is 
enabled. It incorporates resource constraints into the analysis. 
The CCPM (early/late – start/finish) values will match closer 
with the tasks scheduled dates and can expose opportunities 
for plan improvement. However, most users will probably find 
that the CPA provides more information about areas to 
improve the project plan. Looking at a project plan that is 

resource leveled with CPA underlay-ed on the chart can be an eye opening experience. The user should experiment with both methods to see what works best for their 
project. 
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JxProject 2.7.0.2 – Date and Time Line Formatting 

User Documentation 

April 12, 2012 

  

Milliseconds (1/1000th second) is the basis of the time/date utilities of the Java platform and jxProject. Any place in time is measured as the number of milliseconds 
from the Unix epoch on January 1, 1970, 00:00:00 GMT. All time calculations in jxProject are performed in milliseconds. This is a higher level of detail than most 
projects require, however the detail is available if you need it. Java has several time/date utilities used to format these millisecond values into calendar formats. This is 
done when the user specifies a date format pattern to be used for formatting the millisecond values. The date formatting capabilities of jxProject ride very close to the 
Java platform capabilities. Formatting milliseconds into dates is performed by the class: java.text.SimpleDateFormat. If you want to get more information on date 
formating perform a Google search on “java SimpleDateFormat” and you will get a lot of good information. 

Date Format Dialog: 

 

 
 
The Date Format Dialog has two roles; it allows the user to select from a defined set of date formats and to modify or create new date formats. Any time this dialog 
appears you can select from existing formats or define and select new formats. 

Date Format Dialog Table: 

1. Row: The rows are numbered sequentially starting at 1. A row number with an asterisk next to it ( i.e. 7 * ) indicates a user defined date format, or a default date 
format which has been modified by the user. 

2. Description: A modifiable description of the date format.  

3. Format String: This is specific formatting string for converting milliseconds to calendar date strings. This string must follow the formatting conventions of the Java 
class: java.text.SimpleDateFormat. 

4. Result: If the Format String is valid, this will contain the current date, formatted with the Format String. If the format string is invalid, this will contain the text 
“Date Parse Error”. You cannot assign invalid date formats for use in other parts of the application. 

Date Format Dialog Buttons: 

1. Up: This will move the currently selected row, up one row. 

2. Down: This will move the currently select row, down one row. 

3. Copy: This will make a copy of the currently selected row and insert it into the table at the currently selected row. 

4. New: This will create a new row, at the currently selected row, or at the bottom of the table if no row is currently selected. 

5. Restore: The application comes with several predefined date formats. This will go through the table of formats searching for those predefined format Strings. If 
the exact format string is not found, it will be added back into the table. If the the string is found, the entire row will be restored to its default values. Any new 
data formats added by the user will be unchanged. 

6. Delete: This will delete the currently selected row. 

7. OK: Save all changes and apply the selected date format to the element which opened the dialog if it is valid. Then close the dialog. 
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8. Apply: Save all changes and apply the selected date format to the element which opened the dialog if the date format is valid.  

9. Cancel: Cancel any and all changes since the dialog was opened or last “applied”. Do not apply the selected date format to the element which opened it. Close 
the dialog. 

Date Format Dialog Behavior: 

There are four places where this dialog is currently used; 1) Tools -> Date Formats ... 2) Gantt Table Start Date column header pop up 3) Gantt Table 
Finnish Date column header pop up and 4) date pattern selection from the time line format dialog. There are no connections between the elements of the 
application that use the date formats. You may define and assign a date format, and then delete that format from the dialog without affecting the 
components which are using that format. This is because the formatting string is assigned to the elements, not a link to a record in the date format table. 
This makes managing the date formats very flexible. All of the date formats in the date format dialog are stored with the users preferences. 

An example: The user wants to change the date format of the Start date in the Gantt table. The user right clicks the header and selects the “Date Format...” 
menu item. The current start date format string is sent to the dialog before it is shown to the user. If the exact format string is found, that row is selected. If 
the format string is not found, it is added to the table and selected with a description that says “unknown”.  

Note: The text and descriptions below regarding Date and Time Patters are directly from Oracle documentation on the class java.text.SimpleDateFormat. There is 
more complete information and examples if you read Sun's JavaDoc on SimpleDateFormat which you can locate on the Internet by searching on “java 
SimpleDateFormat”. 

Date and Time Patterns: 

Date and time formats are specified by date and time pattern strings. Within date and time pattern strings, unquoted letters from 'A' to 'Z' and from 'a' to 'z' are 
interpreted as pattern letters representing the components of a date or time string. Text can be quoted using single quotes (') to avoid interpretation. "''" represents a 
single quote. All other characters are not interpreted; they're simply copied into the output string during formatting or matched against the input string during parsing.  

The following pattern letters are defined (all other characters from 'A' to 'Z' and from 'a' to 'z' are reserved):  

Pattern letters are usually repeated, as their number determines the exact presentation: 

 
 
TimeLine Format Dialog: 

 

Letter  Date or Time Component  Presentation  Examples  

G  Era designator  Text  AD  

y  Year  Year  1996; 96  

M  Month in year  Month  July; Jul; 07  

w  Week in year  Number  27  

W  Week in month  Number  2  

D  Day in year  Number  189  

d  Day in month  Number  10  

F  Day of week in month  Number  2  

E  Day in week  Text  Tuesday; Tue  

a  Am/pm marker  Text  PM  

H  Hour in day (0-23)  Number  0  

k  Hour in day (1-24)  Number  24  

K  Hour in am/pm (0-11)  Number  0  

h  Hour in am/pm (1-12)  Number  12  

m  Minute in hour  Number  30  

s  Second in minute  Number  55  

S  Millisecond  Number  978  

z  Time zone  General time zone  Pacific Standard Time; 
PST; GMT-08:00  

Z  Time zone  RFC 822 time zone  -0800  
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The “TimeLine” Format Dialog is used to format the headers for the Gantt and Schedule charts. It allows custom date formats, date alignment, alternating intervals to be 
defined for both top and bottom scales. This dialog is accessed from the chart headers by right clicking on the header and selecting “TimeLine Format...” from the pop 
up menu.  

You can stretch and compress the time line by holding down the shift key and press/hold the right mouse button, and drag to the left or right. As the scale of the time 
line is changed in this way, the time line formats are automatically selected and implemented to format the time line. If you have the dialog open while you are stretching 
the time line, you will see the format being used getting selected. 

TimeLine Format Dialog Table: 

1. Row #: The rows are numbered sequentially starting at 1. A row number with an asterisk next to it ( i.e. 7 * ) indicates a user defined format, or a default format 
which has been modified by the user. 

2. Enabled: If enabled, it is can be used for formatting the header, if not enabled, it will be not be used. 

3. Pixels per day: This is the scaling factor over which this format will be used. Typical computer screens display about 100 pixels/inch or 40 pixels/cm. If the 
header is set to a scale of 115 pixels/day it means the 24 hour representation of the day will typically occupy 115 pixels on your computer screen which would 
translate to a visual width of 1.15 inches/45 cm. This is the “key” field/value for determining which format to use for the time line. 

4. Top Units: For the top scale, this is a pull down menu ranging from seconds to years. If this is set to “days” then 1 interval is one day. 

5. Top Interval: For the top scale, this determines the number of intervals per display. For example, if the units are months years, and the interval is 3, then every 

3rd month is shown on the time line, which is basically quarters. 

6. Top Date Format: For each displayed interval, this date pattern is used to format the date. You can edit the format string directly in the cell, or select the “...” 
button and the date format dialog will be shown and you can select/define a date format in that dialog. If the date format string is invalid, the text on the header 
will display “Date Parse Error” at every displayed interval. An empty value is valid and results in not text being written to the display interval. 

7. Top Date Alignment: This is a pull down menu with values left/right/center. The text string of the date will align within its interval according to this value. Note: 
The millisecond time used for producing the date string is taken from the left most position of the interval regardless of the text alignment value. 

8. Top Tick Lines: This is a boolean (true/false) to display vertical lines between each displayed interval. 

9. Scale Divisor: This is a boolean (true/false) to display a horizontal line between the top and bottom scales. 

10. Bottom Units: For the bottom scale, this is a pull down menu ranging from seconds to years. If this is set to “days” then 1 interval is one day. 

11. Bottom Interval: For the bottom scale, this determines the number of intervals per display. For example, if the units are months years, and the interval is 3, then 

every 3rd month is shown on the time line, which is basically quarters. 

12. Bottom Date Format: For each displayed interval, this date pattern is used to format the date. You can edit the format string directly in the cell, or select the 
“...” button and the date format dialog will be shown and you can select/define a date format in that dialog. If the date format string is invalid, the text on the 
header will display “Date Parse Error” at every displayed interval. An empty value is valid and results in not text being written to the display interval. 

13. Bottom Date Alignment: This is a pull down menu with values left/right/center. The text string of the date will align within its interval according to this value. 
Note: The millisecond time used for producing the date string is taken from the left most position of the interval regardless of the text alignment value. 

14. Bottom Tick Lines: This is a boolean (true/false) to display vertical lines between each displayed interval. 

 
 
TimeLine Format Dialog Buttons: 

1. Up: This will move the currently selected row, up one row. 
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2. Down: This will move the currently select row, down one row. 

3. Copy: This will make a copy of the currently selected row and insert it into the table at the currently selected row. 

4. New: This will create a new row, at the currently selected row, or at the bottom of the table if no row is currently selected. 

5. Restore: The application comes with several predefined formats. This will go through the table of formats searching on the “Pixels per day” field for those 
predefined formats. If the value is found, it will be have all of its values set back to their original values. If the the string is found, the entire row will be inserted. 
Any new data formats added by the user will be unchanged. 

6. Delete: This will delete the currently selected row. 

7. OK: Save all changes and apply the selected “Pixels per day” format to the time line which opened the dialog. Then close the dialog. 

8. Apply: Save all changes and apply the selected “Pixels per day” scale and format to the timeline which opened the dialog. 

9. Cancel: Cancel any and all changes since the dialog was opened or last “applied”. Close the dialog. 

Date Format Dialog Behavior: 

When the dialog is opened, the currently active format for the header will be selected. If you stretch/compress the time line while the dialog is open, the 
selected format will change. The format which is used by the time line is that which has a “Pixels per day” value which is closest but less than or equal to 
the headers current “Pixels per day” scale. The defined time line formats are active for both Gantt and Schedule headers, you cannot define a different set 
of formats for each header. By default, the formats are sorted by “Pixels per day”. It is not necessary that they be sorted, but it is probably easier for the 
user to maintain if they are. 

If there are formats which you do not like, you can delete them, but the recommendation is to disable them so they can be easily restored if you want them 
back. 

Although most time line formats have the top scale as the major scale, you can have the major scale on the bottom with the minor scale on top. The header 
will always try to align the top and bottom scales, for example year/months will align, but months/weeks won't align, weeks do not necessarily start or end 
on month boundaries. 
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JxProject 2.7.0.2 – Resource Leveling 

User Documentation 

April 12, 2012 

  

Resource leveling involves accounting for the availability of resources when scheduling tasks and preventing resources from being over allocated.  A resource is over 
allocated when scheduled to perform more work than is possible within the resource's schedule.  Example: If a person is scheduled to work 8 hours on Monday and is 
then scheduled to work full time on four tasks on Monday, then this resource would need to put in 32 hours of work to stay on plan.  It is not possible to work 32 
hours per day! In order to build a realistic project plan, resource leveling is a requirement of the planning process and jxProject provides very accurate resource 
leveling capabilities. 

Resource leveling is not resource optimization.  A project plan that has no over allocated resources does not mean the plan makes good use of the resources. The 
optimization of a project plan entails the identification of unused resource work time and identifying tasks that can be scheduled into the available time. JxProject 
provides an automated resource optimizing capability which reschedules tasks into available work time. In addition, jxProject contains several other tools/features to 
assist the user in further optimization. 

Resource leveling and optimization are achieved through the task ranking capabilities of jxProject.  

Rank and Resource Leveling: The rank is used to determine the order/priority in which resource work time is allocated. Example: Task-A (Rank 5) and Task-B is 
(Rank 6). Task-A, has priority over Task-B with regards to resource work time as Task-A has a LOWER rank value.  

In the above example, the rank of Task-B will delay its start, relative to Task-A, ONLY if ALL of the following conditions are true:  

1. Resource leveling is enabled 

2. Neither of the tasks is a summary task 

3. The tasks have at least one resource in common 

4. Simultaneously scheduling Task-A and Task-B will result in an overallocation of at least one the resource(s) in common 

5. The earliest possible start time of Task-B is sooner than the finish time of Task-A 

Note: In situations where there are multiple tasks with partially assigned resources, the partial allocations are additively considered. Example: Task-A (Rank 5), Task-B 
(Rank 7), Task-C (Rank 14), Task-D (Rank 22), all have resource Bob assigned at 30% to each of the four tasks and all of the tasks are occurring simultaneously. 
The task with the highest rank value(Task-D) will be pushed out to avoid overallocation, but the first three tasks will be free to start at their earliest possible times. 
{(3*30 = 90%) < 100%} is OK, but {(4*30 = 120%) > 100%} would not be allowed by the resource leveler. 

Task Rank Display: The rank of a task is visible in the Gantt Table column labeled Rank. It is displayed as in the following example: “23 – 19 > 11”. The first value
(23) is the rank, the second value(19) is the lowest rank value for this task before hitting a hard constraint. The last value(11) is the absolute lowest rank value that this 
task can assume given the project plan structure. Often you will see “*” in the rank display, for example: “27 * > 23”. The * means that the value is the same as the 
value to the left. In this example, the * represents 27. The task ranked number 1 will always be seen as: “1 * *”, as it is already at its lowest possible value. 

Rules of Rank: 

By default, tasks are ranked from top to bottom starting at 1 (one) and incrementing by one for each task.  

1. The rank of each task is a unique positive integer value.  

2. A successor task always has a higher rank value than its predecessor(s).  

3. A summary task always has a rank value that is one higher than the highest rank value of its child tasks. 

4. The structure of the project plan, task parent/child relationships and task links [FS, FF, SF, SS, RU] are subject to the rules of rank and no changes to the rank 
of a task can violate these rules. 

5. The rank of a task will not change unless a change to the project plan structure requires it in order to conform with the above rules, or the user initiates a change 
of rank by the means outlined below. 

How to alter the rank of a task: 

1. Change the structure of the project plan: Task parent/child relationships or task links [FS, FF, SF, SS, RU] 

2. Use Pseudo link types Ra+ and Ra- in the Gantt Chart. 

3. Edit the rank cell value in the Gantt Table. 

4. Initiate the resource optimizer from the Gantt View. If an optimization opportunity is identified, it will alter the rank of tasks to achieve the optimization.  
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Link Type RU : 

This is a Resource User link and can be thought of as a soft link. The only constraint that this link enforces is that the successor task must have a higher 
rank value than the predecessor task. This link can be used to ensure that one task has priority over another task in any competition for resources. 

Pseudo link types Ra+ and Ra- : 

The rank of a task is only significant in its relationship to other tasks that have resource(s) in common. The pseudo links provide a familiar method of 
altering the rank of a task by specifying that a specific task is to be ranked later than another task. For these operations, the desired result is that the 
successor task is assigned a higher rank value than the predecessor. To use these tools, the user must be in the Gantt view, and select the Ra(+/-) link type 
from the “link type” pull down on the tool bar. Then click down on the predecessor and drag to the successor and release the mouse. This is the same 
method/interactoin as creating hard link dependencies, but no link is created in this operation, only changes to the ranks of the tasks.  

Rank Adjustment Positive [Ra+]: For this Pseudo link type, the successor task rank is increased to be one higher than the rank of the predecessor 
task. This operation is used to push the successor forward in the project plan. To schedule the successor at a later date. 

Rank Adjustment Negative [Ra-]: For this Pseudo link type, the predecessor task rank is decreased to be one lower than the rank of the successor 
task. This operation is used to pull the predecessor back in the project plan. To schedule the predecessor at an earlier date. 

There are many situations where the results of these operations will differ from what you might expect. If the rank of the successor task is greater than the 
rank of the predecessor task, no changes will be made as the ranks already comply with the action. If the Pseudo link would form a circular constraint 
violation if it were a real link, then no rank changes can be made. If performing an Ra+ operation, and the pseudo link successor has one or more “real” 
successor tasks ranked between the tasks of the pseudo link, then those successor task(s) will be pushed forward in the schedule along with the pseudo 
link successor. This will drop the pseudo predecessor back in the schedule further than you might have expected. There are times when the results of these 
two operations (Ra+, Ra-) will produce the same result. 

When the rank of one task is changed, it necessitates the change to the rank of at least one other task. The rank is the mechanism by which the tasks 
compete for the resources to get them done. The structure of the project plan dictates how close the rank changes attempt to make can actually be 
implemented.  

After you have attempted a pseudo link operation, check to see that the successor rank is higher than the predecessor rank, if it is, then the operation was 
successful, even if the results were not quite what you expected.  

Editing the rank cell value in the Gantt TreeTable: 

To edit the rank in the Gantt Table, click on the rank cell you wish to edit and you will be presented with a spinner editor. You can increase/decrease the 
value and then push enter to submit the change. The resulting rank might not always be what you expected as any changes must comply with the rules of 
rank. If you attempt to set the rank of a task to the highest possible value, this will not be possible if there are one or more successors to the task. In this 
case the rank will be set as high as possible within the rules of rank.  

If you attempt to set the rank of a task to the same value as the rank of another summary task, the resulting rank will be one higher, or lower, than what 
you requested. This is because a summary task always takes all of child tasks along with it, you are always dealing with more than one task when working 
with ranks of summary tasks. 

The Resource Optimizer [The “Op” button]: 

To initiate the optimizer the user must click the “OP” button on the tool bar. This will start a process to identify and reschedule a task to an earlier start 
date within the following restrictions: 

Each push of the button performs, at most, a single task optimization within the above restrictions. When a task is successfully moved by the optimizer, it 
often has a cascade effect causing other tasks to be rescheduled earlier. This is considered a desirable result. If no qualified optimizations are identified by 
the optimizing process, no changes are performed.  

All changes performed by the optimizer are subject to undo/redo. 

Push the “Op”button as often as you like. The free version of jxProject has a limit to the number of optimizations that will be performed. Once this is 
exceeded the button will be disabled. See the purchase/buy section of jxProject.com for more information. 

Resource Optimizing Strategy: 

The resource optimizer described above does not guarantee that your project plan is fully optimized with regard to resource utilization. It is a powerful tool, 
but it operates under a very tight set of restrictions and only makes changes where there are no trade off decisions to be made. For example, if the 
optimizer finds a task that requires four months of work can be scheduled 6 months sooner, but moving the task would overlap another task by 1 minute, it 
won't move the task! 

1. The rescheduling of the task must result in the task starting earlier 

2. The rescheduling of the task can not cause the start date of any other task to be increased. 

3. The optimizer can only alter rank values. No other modifications are allowed. 
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The project manager needs to perform any rank changes that require “trade off” decisions. From the tools described above, the best are the Ra- pseudo 
link and undo/redo. Working to identify tasks that can happen sooner than they are currently scheduled is a natural way for a project manager to think. 
Pulling tasks back in the schedule often yields results that are closer to what the user expects. Also, both of the pseudo link tools make “relative” changes. 
Changing the rank of one task relative to another is more predictable than setting an absolute rank value using the table cell editor.  

The undo/redo is an important tool as it allows the user to clearly observe the impact of the last change. You can pop back and forth with the undo/redo 
and get a “before” and “after” graphical, almost animated, view of the impact on the entire project plan. 

Discussion: 

I want to share some more of my ideas for further resource optimization in jxProject. I'm doing this in hopes of getting feedback/ideas from users. 

I really like the way this has come together. You can build any kind of project plan, have it fully resource leveled and have some good optimization tools. 
However, I feel there is some opportunity for improvement in helping the user/project manager locate more optimization opportunities. Here's an idea: The 
resource view shows the calendars and resources and their schedules and the assigned tasks. In that view you can clearly see the gaps (work time with no 
assigned task) in the resource schedules, but you can't reschedule tasks in that view or see task dependencies. I'm thinking it would be helpful to allow the 
user to reschedule tasks by drag/drop in the chart. But, I would need to show the user what changes were possible for each of the tasks ... show the early 
start date and late finish dates, float, stuff like that. Maybe even allow tasks to be assigned to different resources in that view. If the user knew the early 
start for each task, they would know how early they could be scheduled. It would allow the project plan to be developed/optimized from the resource and 
project perspectives. I think it would be more useful than any algorithms I could develop. 

Ok users, discuss amongst yourselves. Let me know what you think. :-) 
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jxProject 2.7.0.2 – Printing/Imaging 

User Documentation 

September 23, 2011 

 
 

Printing/Imaging: The interface for printing or writing out html and images is largely the same. When printing you must choose from an available selection of installed 
printers and paper sizes, but when writing out html/images, you are free to select whatever image size you desire. You can switch between HTML and Print mode using 
the pull-down menu on the lower tool bar. 

Printing Mode: 

When you elect to print, you are always brought to a print preview window looking similar to the one below. 

 

 
 

Content Scale: This allows you to change the amount of scaling of the table/chart across the pages.  A larger content scale will spread the table/chart across more of 
the existing pages or onto additional pages if space is needed.  A smaller scale will shrink the table/chart onto fewer pages.  You could take a large project plan and 
shrink it down to the size of a postage stamp if you wanted.  A scale of 0.60 is a good scale for maximum content on the minimum number of pages while maintaining 
readability. 

Zoom Scale: This zoom scale allows you zoom in or out on the page.  Increasing zoom scale magnifies the view on the computer screen. 

Print…:  This will start the actual printing to your default printer.  A progress bar will be displayed during the printing to keep you informed of the print progress. 

Close: This will close out the print preview and take you back to the Gantt or Schedule view from which you came. 

Printer Select...:  This brings up a dialog which allows you to select printer a printer. (Note: Graphic needs updating) 

Paper Select...:  This brings up a dialog which allows you to select the paper to use for printing.  Note: although this dialog usually has a button which allows printer 
selection, it usually does not work. There is a bug logged with Oracle regarding this problem but there is no date given as to when it will be corrected. Use the “Printer 
Select...” button to select a different printer. (Note: Graphic needs updating) 

HTML Mode: 

In order to post project plans on the web or to produce images that can be incorporated into other electronic documents, you would want to use this feature. The 
HTML mode of the print preview allows you to write out the project plan as a combination of HTML and image files. You can then post the html/images to the web as 
is, or in a modified form. If you just want to use the images, you can discard the html. The image files produced will be named similarly to html file name that you specify 
when saving. Example: projectPlan.html would have associated image files: projectPlan _01.jpeg, projectPlan _02.jpeg, projectPlan _02.jpeg... 
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Save As...:  This will bring up a file save dialog with a default file name which is the same as the project file name with an html extension. When you say “OK” to that 
dialog, jxProject will write out an html file along with several image files of the type which you specified in the Image Setup dialog. If open this html file in your web 
browser, you will see the simple web page and your images arranged much like they are here in the print preview.  

Close: This will close out the print preview and take you back to the Gantt or Schedule view from which you came. 

Image Setup...:  This dialog allows you set parameters associated with producing the images that are saved along with 
the html. 

l Input (width/height): The width and height of the entire image. Note: The width/height measurements do not include the headers and footers of the images and 
do not account for page break spacing where the images are divided along row and column boundaries.  

l Type: This is the type of image to be produced. The available image types will be determined by your platform and the JVM vendor. On the Windows platform 
using the Oracle JVM, the jpeg and png formats are available. Note: The png format is very efficient, it produces images which occupy less space and are 
clearer than jpeg images. Although support for the png format is good among the technology industry, it is not as widely supported as jpeg. 

l Border: A pixel measurement as to the amount of white space to place around each image. 

l Width: The width of each image in pixels. Note: Associated inch and cm measurements are based on 72 dpi. 

l Height: The height of each image in pixels. Note: Associated inch and cm measurements are based on 72 dpi. 

l Set As Defaults: This will store the current image settings as default values in your user profile. The next time you initiate an HTML/output image session, you 
saved default values will be utilized. 

l Restore Defaults: This will retrieve the image values from your profile that you last saved as default values and load them into the dialog. 

l OK, Apply, Cancel: In order for changes in the dialog values to be applied to the “print preview” representation, you must Apply or OK the changes. Cancel 
will dismiss the dialog without applying the changes. 
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jxProject 2.7.0.2 – Activation 

User Documentation 

April 12, 2012 

In order to activate jxProject you must first obtain a valid serial number. Serial Numbers can be purchased directly from the www.jxProject.com web site or from an 
authorized reseller. The benefits of activation are outlined in the purchase/buy section of jxProject.com. 

The benefits of activation are listed in the purchase/buy section of jxProject.com web site. 

In order to activate jxProject, perform the following steps: 

1. Download, install and run the sponsored version of jxProject. The download and installation instructions and software are found in the download section of 
jxProject.com. 

2. From the jxProject application, bring up the Product Activation dialog by selecting Tools-> License Activation... 

3. In order to make sure that the activation system is alive and ready, switch over to the “Testing” tab of the Product activation dialog and push the “Run Test” 
button. This will initiate a connection with the jxProject servers and the activation system utilizing your network/proxy settings, if you have them set. If the test is 
successful, then your network connection is good, and the activation servers are ready to go. If the access fails, there should be a message which indicates what 
went wrong. On very rare occasions, the activation system is taken off line for maintenance. If this is the case, a message will be returned giving the reason and 
when the system is expected to be back on line. 

4. Obtain a jxProject serial number. 

5. From the Activation tab, enter your serial number and user information. 

6. Press the “Submit Activation Request” button. The information you enter as well as the information in the User/Machine Information area is used to produce an 
encrypted hash activation request. The activation request is then sent to the jxProject servers, which validate the request and appends several encrypted 
activation keys to complete the license. The license is specific to the machine and the user. 

7. If your network connection is at least as fast as a dial up modem, the activation process should take less than 3 seconds to complete after submitting the request. 
If the activation is successful, the advertising window of the application will be immediately be removed. If it is unsuccessful, check the “Activation Status” area 
to find out what the problem was. You can always contact support@jxProject.com if you have problems. 

The Product Activation Dialog: 

l Serial Number: The serial number is all numeric, except the dashes. 

l First Name, Last Name: This should be the users first and last name. The values entered 
here will appear as the name of the Activated User on the jxProject splash screen. 

l e-mail, Phone Number: This should be the users email and phone number. This is just so 
we have some way of contacting our users if we need to let them know about issues with 
the software. 

l User/Machine Information: This information is gathered automatically from your 
machine environment and is used to generate the activation request keys. 

l Activation Status: This shows current information about the activation status of the 
software. During the process of activation, information about the process is posted here. If 
there is a problem, you would want to look here for information. You would want to email 
this information to support@jxProject.com if you need assistance or further explanation. 

l Submit Activation Request: When you push this button, the activation process begins. If 
you currently have an active license, you will be prompted to confirm that you really want 
to move forward with a new activation. Once an activation has been submitted and is 
successful, this button will be disabled to prevent the user from accidentally submitting 
more than one request. 

l OK, Cancel: Both of these buttons dismiss the dialog, the functionality is the same. 

Notes on the activation process and upgrading: 

1. Upgrades of jxProject will respect the activation license of any previous version of jxProject. For example, you activate version 2.0.0.2, and then 
upgrade a month later to version 2.1.0.2, the new version will run as an activated application until the activation expires. For another example, lets say 
you un-install an activated version 2.0.0.2 and then reinstall 2.0.0.2 and/or 2.1.0.2, your license and activation will still be valid for both versions. 

2. The activation process uses HTTP protocols and session identifiers (HTTP cookies). If you are behind a firewall which removes session identifiers, you 
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won't be able to retrieve the completed license to complete your activation. You will get a message in the Activation Status telling you that it could not 
retrieve the license. If this happens to you, contact support@jxProject.com and your activated license file can be emailed to you. Firewalls that block 
HTTP cookies are very rare, it does not increase security and renders purchasing over the Internet difficult/impossible for all of its users.  

The activated jxProject splash screen:  

l Version: The is the software version number that is currently running. 

l Expires: This is the date that this version of the software expires. This is not used for production 
releases of the software, this is for beta versions only. 

l Activated User: The first and last name of the user that activated this installation of jxProject as entered 
in the Product Activation dialog at the time of activation. 

l Serial Number Hashcode: The hashcode is generated from the serial number which was used for the 
activation. You cannot derive the serial number from its hashcode, and the hashcode cannot be used for 
activation. It is a reference to the serial number which the jxProject company can use to locate the serial 
number if it is lost by its purchaser. 

l Activation Expires: This is the date and time at which the activation will expire and the software will 
revert back to the advertising version. However, there is a 7 day grace period after the activation 

expiration before the advertising becomes active again. 

The Network Settings Dialog: 

This is the Network Settings dialog. It allows the user to set the machine and port values for networks which use 
proxies to access the Internet. Internet access is only needed to support the updating of advertisements for the 
sponsor window of the jxProject application. If an authenticating proxy is being used, the username/password will 
be prompted for at the time of access. As a security precaution, the username/password are not stored or written 
to disk.  

Testing Tab: This allows the user to test proxy access by attempting to retrieve a file from jxProject.com using 
the user specified proxy settings. The success or failure to access the server is shown to the user in detail. 
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JxProject 2.7.0.2 – Advertising/Sponsor Updating 

User Documentation 

September 23, 2011 

The jxProject application is supported by advertisers. Advertising supported software is often referred to as “Ad Ware”. In general the quality of Ad Ware is 
significantly better than free ware, although it does have its controversies. Anyone who purchases advertising, regardless of the medium, wants to know the size of the 
audience, and how many times the ad has been seen. Therefore, it is necessary to pass information from the application, to the server about which ads were displayed, 
and for how long they were displayed. The controversy around this involves issues of privacy. A natural question is, what data is being collected? Many Ad Ware 
companies have been very evasive about what information is being uploaded, only to find out later that the software was collecting a significant amount of information 
beyond the scope of what was needed. They installed completely separate applications that were running every time you started your computer and tracked every 
keystroke or website you visited. Thus came the term “spy ware”. These applications often slowed the performance of your machine, sometimes would cause it to 
become unstable, were a complete invasion of privacy, and if you un-installed the original software, the spy ware would remain on your computer! I had some spy 
ware on one of my computers years ago that came courtesy of the RealPlayer software from RealNetworks.com. To this day, and forever more, I won't touch anything 
that comes from that company. They compromised my trust, let em' rot. So now you know my personal feelings on the spy ware issue. ;-) 

If you have had an experience like mine, you are very, very selective about what software you install on you computer. I want jxProject to be an application that you 
trust. In order to build that trust, I am going to tell you exactly how the advertising process works and what information is being exchanged. I wrote every line of this 
software, I know exactly what it does and does not do. 

Below is a copy of the exact data that the jxProject uploads from my machine to the server when the updating of advertisements takes place. There is no information 
here that I am nervous about publicizing. I figure if you are going to trust me with your data, I can trust you with mine: 

<?xml version="1.0" encoding="UTF-8"?> 

<Configuration> 

<Setup ads="113895293" home="-1305343180" install="1056863705234" /> 

<Environment user.country="US" user.language="en" user.timezone="America/Los_Angeles" os.name="Windows XP" os.version="5.1" java.version="1.4.1_03" /> 

<SponsorControl productVersion="1.0.0.1" version="1" loadStatus="2" install="1056864259609"> 

<SponsorInfo slot="10" displayTime="10000" fileName="jxpPlanYourSuccess.gif" HTTPAddress="www.jxproject.com" toolTip="Plan it" displayCount="22" problemCount="0" gotoURLCount="0" animate="false" 

enabled="true" /> 

<SponsorInfo slot="20" displayTime="10000" fileName="jxpAckJava.gif" HTTPAddress="www.java.com" displayCount="22" problemCount="0" gotoURLCount="0" animate="false" enabled="true" /> 

<SponsorInfo slot="30" displayTime="10000" fileName="jxpPlatformsXML.gif" HTTPAddress="www.jxproject.com" displayCount="21" problemCount="0" gotoURLCount="0" animate="false" enabled="true" /> 

<SponsorInfo slot="40" displayTime="10000" fileName="jxpAckJDOM.gif" HTTPAddress="www.jdom.org" toolTip="Java XML tool" displayCount="21" problemCount="0" gotoURLCount="0" animate="false" 

enabled="true" /> 

<SponsorInfo slot="50" displayTime="10000" fileName="jxpPriceQuestion.gif" HTTPAddress="www.jxproject.com/products.shtml" displayCount="21" problemCount="0" gotoURLCount="0" animate="false" 

enabled="true" /> 

<SponsorInfo slot="60" displayTime="10000" fileName="jxpAckNetBeans.gif" HTTPAddress="www.netbeans.org" toolTip="Sun Java IDE" displayCount="21" problemCount="0" gotoURLCount="0" 

animate="false" enabled="true" /> 

<SponsorInfo slot="70" displayTime="10000" fileName="jxpStandard468x60.gif" HTTPAddress="www.jxproject.com/services.shtml" displayCount="21" problemCount="0" gotoURLCount="0" animate="false" 

enabled="true" /> 

<SponsorInfo slot="80" displayTime="10000" fileName="jxpStandard392x72.gif" HTTPAddress="www.jxproject.com/services.shtml" displayCount="21" problemCount="0" gotoURLCount="1" animate="false" 

enabled="true" /> 

<SponsorInfo slot="90" displayTime="10000" fileName="jxpCustom468x80.gif" HTTPAddress="www.jxproject.com/services.shtml" displayCount="21" problemCount="0" gotoURLCount="0" animate="false" 

enabled="true" /> 

<SponsorInfo slot="92" displayTime="10000" fileName="jxpYourAdHere.gif" HTTPAddress="www.jxproject.com/services.shtml" displayCount="21" problemCount="0" gotoURLCount="1" animate="false" 

enabled="true" /> 

<SponsorInfo slot="94" displayTime="10000" fileName="Donkey.gif" HTTPAddress="www.jxproject.com" toolTip="bogus broken image" displayCount="0" problemCount="0" gotoURLCount="0" animate="false" 

enabled="false" /> 

</SponsorControl> 

</Configuration> 

 
I don't want to go over every piece of data in detail, but this is XML and the tags make it fairly self explanatory. The Setup Element has validation information about the 
installation of jxProject. The Environment Element has country, timezone and the language setting of the computer, the operating system version and the lava version. 
The SponsorControl Element has information about how the advertisements were loaded, and below that are the SponsorInfo Elements which contain information 
about each advertising image. SponsorInfo gives the position/slot, how long the ad is seen each time it is displayed, how many times it was displayed and how many 
problems there were showing the image. If an image has problems, it will be disabled so it doesn't display any more. 

If you look at the last SponsorInfo that has the fileName=”Donkey.gif”, that file has zero display counts. That's because this is a test condition where the ad was not on 
the server, so it couldn't be loaded, so it is disabled before an attempted was made to display it. Hey, it works! 
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Think about this, you know that the data above is from my computer because I just told you. And although you probably don't know me personally, you know I am the 
person that wrote jxProject. When your advertising data is uploaded to the server, I don't have any idea who you are. All I can tell is that you are some user of 
jxProject on the Internet that has some data. On a related note, jxProject does not have any tracking identifiers or “cookie” type of capabilities. 

How the process works: 

The first time you run jxProject it will run a set of default advertisements that come with the application. However, every 15 minutes it will ask you if you want to update 
the advertisements. If you say no, it will ask you again 15 minutes later and it will keep doing this every 15 minutes until you say “yes”. (You can just keep saying “no” 
forever if you want, that's fine) Once you say “yes”, the upload progress dialog will be loaded into the sponsor window so you can monitor the update process. 
However, you can continue working with your project plan, you don't have to stop while the update is taking place. It will first upload your advertising data, and then it 
will download any new advertisements that it doesn't already have. If everything is reasonably successful, the dialog will turn green when the update is complete, or red 
if the update failed. NOTE: If you must use a proxy to access the Internet, you can access the proxy options under the Tools -> Network Settings. See the Gantt user 
documentation for details on the Network Settings dialog. 

Once the advertisements are updated, you will not be prompted to update them again for another 14 days.  

If you want to update your advertisements more often then every 14 days you can do this by selecting Tools–>Update Advertisements. This will bring up a dialog 
asking you to confirm that you want to update, if you say “yes” the update begins as described above. However, you cannot update your advertisements more than 
once every two days. You will get a dialog telling you the ads are already up to date or something like that. 

You might ask yourself, why would I want to update more often than required? Here's the situation I envision. Lets say you have a laptop that you use for jxProject and 
you are going on a trip where you won't have reliable Internet access. You would want to update your ads just before you go so you don't get stuck having to answer 
“no” every 15 minutes because you don't have Internet access at the time the 14 day update period expires. 

How the data will be used: 

Anybody who advertises with jxProject will get access to this data. I still need to write some software to summarize the data into digestible reports. I doubt anyone will 
want the raw data from each upload, because it isn't that interesting. For example, from my data you can see that I live on the west coast of the US, speak English and I 
saw each ad 21 times. WhoopDeDo! However, what will be interesting to see however what percentage of users are on the West coast versus the East coast. Or, 
what percentage of the users speak French or Italian. The aggregate data is what is interesting, not the individual data. 

On a side note: I don't know if an advertiser would be interested in the operating system that is being used, I put that in there for myself so I know what systems I need 
to support. Many of the people I get email from are on Mac OS-X, which I don't officially support, but if I find that I have a lot of users there, maybe I'll need to 
reconsider. Apparently jxProject works well on the Mac at this time and I hope that continues, I just don't have any way of testing on that platform so I don't want to 
tell people it will run on a Mac when I'm not sure that it will. 

How do I find out more about the Advertising? 

Buy some advertising space! You'll get to see the whole operation from the inside and you'll see how it works. See the “Advertising” section of www.jxProject.com. 

Can I turn off the Advertising in jxProject? 

You can purchase a serial number which will allow you to remove the advertising. See the purchase/buy section of the jxProject website. 

Note: There will certainly be those individuals that will be tempted to dis-assemble jxProject in order to disable the advertising requirement. I know that often this is 
done without malicious intent, more of a challenge really. If you are an individual with the skills to do this, I ask, developer to developer, that you please don't. 
Disassembly of jxProject is illegal, but mostly, it's wrong. If you are a user of jxProject, I ask that you purchase a commercial serial number and not use an illegally 
modified version if one is made available to you. Using an illegally modified version of jxProject would also be illegal and wrong and probably loaded with viruses. ;-) 
Thanks – Pete. 
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jxProject – Quick Start 

Editing 

April 12, 2012 

  

This document is intended to get you up to speed quickly with jxProject's basic capabilities by editing/modifying an existing project plan. It is a step by step tutorial 
which touches quickly on editing techniques. This does not cover everything, just the basics. 

1. First load example project plan “A_sampleProject” by choosing the Help pull down from the menu bar button in the Gantt view (Help -> Sample Projects -
>A_sampleProject. This is a project plan that includes Klien, Baer, Clark, Archer, Johnson and Reynolds as resources. Note: There are three example project 
plans that can be accessed for experimentation and learning. 

2. From the Gantt View, select a task(blue rectangle) in the Gantt chart by clicking on it, the outline will turn red. 

3. Now grab(click and hold) the right edge of the selected task and drag the task left or right to increase and decrease its duration and release. (Note: you cannot 
drag summary tasks) 

4. Now right click on the char row of the selected task and select “Flash Schedule” from the context menu. You will observe green boxes which are the work time 
schedules of the resources assigned to the task. 

5. To create a link/dependency, on the Gantt chart click/hold and drag from one row to another. A link will be created between those two tasks, unless there is a 
constraint violation in which case an error will result. The type of link created is determined by the setting of the “Link Creation Type” button which is user 
selectable (FS, SS, FF ... ). Select a link/dependency by clicking on it, it will turn red. 

6. Now grab(click and hold) the tip of the arrow head of the link and drag the link left and right and release. This alters the “lag” associated with the dependency. 

7. Now double click on any link in the project plan Gantt chart. A task edit dialog will pop up, the dependencies tab will be shown, and the dependency selected 
will be highlighted in the table. Hit the “Delete” button to delete the dependency and click “OK” to dismiss the dialog. The link is now gone. Press undo to 
restore the link. 

8. Now lets insert an Arbitrary constraint. In the Gantt Chart, hold down the “shift” key and click anywhere in the chart. An arbitrary “start after” constraint will be 
added. Select the constraint by clicking it, it will have a red outline, now click/hold on the selected constraint and drag it left or right and release. You can also set 
arbitrary constraints by right clicking on the chart to get the context menu and selecting an arbitrary constraint type. 

9. Push the “Op” button and the optimizer will scan the project plan and tighten up the schedule to take advantage of idle time by resources. 

10. Push the undo and redo buttons to see how that works and to undo your changes one by one. 

11. Change the scaling of the timeline by holding down the “shift” key and right click/hold on the Gantt Chart Timeline Header and dragging left and right. Observe 
that the date format of the timeline changes automatically as the scale changes. Note: The Timeline Header is located directly above the Gantt Chart. 

12. Change the row height of the Table and Chart similarly to the timeline by holding down the “shift” key and right click/hold on the Table Row Header and 
dragging left and right. Note: the row header contains the “Key” field for each task. Note: The Table Row Header is the most left column in the table, each cell 
contains the numeric key of the task in the row.  

13. Double click one of the Key values for a task and the edit dialog will appear. Dismiss the dialog by canceling. 

14. Select several rows in the table by click/hold on the “Key” field, drag down and release after about four rows. Now click/hold on on of the selected tasks, on 
the “Key” cell and drag(do this quickly). A ghosted image of the top task will follow along with your mouse cursor and the task will be inserted just above the 
task that you release the mouse on. (Note: Some moving of tasks will result in a constraint violation and will give an error message). If you wish to copy tasks, 
hold the “cntrl” key down before starting the drag. 

15. To assign resources to tasks, open the “Resource Assignment” dialog by clicking on the “Assign Resources” button on the toolbar. A dialog will pop up showing 
all resources. Select a row in the dialog by clicking on the “Key” cell. Now click/hold drag from the “key” cell and drop it on one of the rows in the Gantt Table. 
The resource will be assigned to that task. To delete all resources for the task, select the “Resources” cell in the Gantt table and right click for the context menu 
and select “cut”. There are many ways to add delete and edit resources but they are not all covered here. 

16. To enter new tasks, select one or more rows in the table. Now right click on the selected rows to bring up the context menu and select “New Task(s)”. New 
tasks will be inserted. Now click on the “Task Name” cell of the task and type in the task name/description and hit return and type in the name of the next task. 

17. To renumber the “Key” values of the tasks after they have been moved about, right click the header of the “Key” column and select “Renumber All Nodes”. 

18.  

Now, lets switch to the Calendar/Resources view. 

1. Switch to the Calendar/Resources view by selecting from the menu bar (View -> Calendar/Resources). 

2. In this view you should see a table with all of 
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